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1 Tekla Structures 2026 release
notes

Welcome to Tekla Structures 2026!

Accuracy in every phase - highlights of Tekla Structures 2026

Tekla Structures 2026 introduces AI and cloud tools, intelligent data workflows,
and enhanced support for design deliverables, to boost productivity and keep
office and site aligned.

Updated AI Cloud Fabrication drawings service

Accelerate the fabrication drawing creation with AI-assisted template selection
and enhanced cloning and associativity. Launched in 2025 as a preview feature
for Diamond licenses, this service has been improved based on feedback.

• The new AI model improves template matching from the cloud libraries,
while a human-in-the-loop step helps fine-tune the AI suggestions.

• The interface has been updated with a clear template preview and top
three AI-based matches. Enhanced cloning ensures reliable placement of
annotations, dimensions, and views for consistent drawings.

• Find out more in the full release notes (page 50)

Project Settings Management Console (Preview)

Simplify the management of project settings by enabling easy sharing and
customization using cloud environments.

• This new, web-based tool ensures all users have consistent, up-to-date
settings throughout the project, preventing errors in the model and
promoting smoother collaboration.

• By simply joining a project, all necessary project files and extensions are
available for users. Administrators can create custom collections and test
them in a sandbox environment before publishing them to all users.

• Find out more in the full release notes
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Trimble Assistant for Tekla

Enhance productivity with AI-powered tools.

• The User Assistant provides quick access to information and personalized
support.

• Reduce manual effort in creating technical code with the Developer
Assistant (Preview).

• Interact with models and drawings intuitively using the experimental Model
Assistant and natural language prompts to simplify tasks and stay focused
on your designs. Model Assistant reads your model context in real-time
and handles the tasks you assign. The feature is available now only in
Trimble Labs as an extension for early feedback.

Simultaneous cross-model and general arrangement drawing editing

Enhance the efficiency of preparing plan, section, and elevation drawings by
editing both the model and the drawing at the same time.

• Modify model and a general arrangement drawing simultaneously, with
both modes displayed side by side.

• Selecting objects in one mode automatically selects the corresponding
objects in the other, facilitating easier navigation. Any changes made to
objects in the model are immediately reflected in the drawing.

• Find out more in the full release notes (page 62)

Intuitive 2D detailing in drawings

Finalize designs efficiently with enhanced drawing sketching, editing, and
annotation tools that are now easier to find and use for creating and editing
drawing detailing objects.

• The renewed and reorganized drawing ribbon contains a dedicated tab for
sketching tools.

• New review cloud options add flexibility, while the new 2D Insulation
command adjusts automatically to the model changes, helping you keep
drawings up to date with less effort.

• Add formatted project notes using the integrated rich text editor.

• Find out more in the full release notes (page 65)

New clipboard functionality for copying and pasting model and drawing
objects

Efficiently reuse model and drawing content with the new clipboard
functionality, enabling you to easily copy and paste model objects and drawing
objects. Now, each time you copy objects in a model or in a drawing, the
objects are always copied to the clipboard, allowing you to later paste model
objects into the current model or any other model, or to paste drawing objects
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into the current drawing or any other drawing in the same or another model,
leading to substantial time-savings.

Find out more in the full release notes (page 13)

New way to manage model views: Model views side pane

Enjoy a modern way to organize and manage the large number of model views
in your project. The new side pane makes it easy to manage and navigate
all model views flexibly but in a controlled manner, and to create general
arrangement drawings of the selected model views.

Find out more in the full release notes (page 19)

Personalized workspace

Customize your in-product workspace appearance.

• Change the model background color (page 27) with one click.

• Position model views and drawings using the new, responsive docking
zones (page 25).

• Use the improved model and drawing autosave (page 30) and set it to
the interval that suits your needs, and restore the autosaved model and
drawing when necessary.

Rebar detailing and drawing rebar annotations

• Gain better control over rebar sets for improved model stability (page 39)
and easily annotate reinforcement in drawings to industry standards.
Specific rebar sets can be frozen to prevent automatic adjustments and
support a modeling approach similar to rebar groups, while retaining the
advantages of rebar sets. Freezing rebars could be useful when they are
already sent to fabrication to avoid any changes.

• The experience between rebar groups and rebar sets has been unified by
adding more controls to rebar set properties. You can split rebar sets using
the familiar split command and adjust covers, offsets and other settings
consistently.

• Improved rebar drawing annotations (page 81) make it easier to annotate
drawings to industry standards.

Re-engineered Bridge creator

Reduce processing time in complex bridge modeling with the re-engineered
Bridge creator, now a native Tekla Structures plug-in storing data in
component objects instead of external files.

• All configuration data is now stored inside component objects, removing
reliance on external files and making modifications straightforward.

• Intelligent automation replaces repetitive manual tasks of shape naming.

• New centralized libraries and rule-based logic now handle station creation
and definition with less effort.
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• Placement of components or beams on curved alignments is now more
consistent thanks to chord-based positioning, which is useful when placing
straight objects along a curved alignment.

• New layout and verification tools, including off-alignment projection and
perpendicular aides, make point placement along the bridge alignment
easier.

• Find out more in the full release notes (page 143)

Enhanced IFC interoperability

Share only the information defined in each stakeholder’s RFIs when exporting
IFC2x3 or IFC4 to reduce follow-up.

• Flexible export options allow selecting and exporting individual objects
even within assemblies, with or without assembly information.

The unified export also supports direct publishing to Trimble Connect.

• Previously fixed IFC entity attributes can now be adjusted, and you can also
change the IFC entity type for reinforcement.

• The IFC4.3 export meets the mandatory requirements for both the building
and bridge domains.

• Find out more in the full release notes (page 110)

Trimble Connect property sets integrated in Tekla Structures

Operate in real time with accurate, up-to-date property data from the
construction site or factory directly in your Tekla Structures model through
the integrated Trimble Connect property sets.

Synchronize and manage property sets from Trimble Connect in Tekla
Structures and use them, for example, in filters, reports, templates, drawing
marks, and IFC exports, similar to regular user-defined attributes or template
attributes.

Find out more in the full release notes (page 97)

Upload PDF drawings to Trimble Connect

Upload drawing PDFs to Trimble Connect with metadata, preventing outdated
drawings from being used.

• When printing drawings, automatically upload and link PDFs directly to the
corresponding parts and assemblies in the Trimble Connect model, storing
drawings alongside the model objects.

• Shop and field crews can pull up the latest drawings on a tablet associated
with the actual object, ensuring that the most current data is being used.

• Find out more in the full release notes (page 100)
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Layout manager - Enhanced workflow efficiency with point deviation
management

• Use the out-of-tolerance check in Layout manager to identify
discrepancies between the design and what has been built, speeding up
decisions on how to correct them.

• Layout manager now comes with an updated user interface that enables
the out-of-tolerance workflow. Automatically identify and colorize out-of-
tolerance points, generate delta-value reports, compare as-designed and
as-built points and add dimensions between them in a drawing. This turns
raw site data into actionable insights and supports timely corrections.

• Find out more in the full release notes (page 119)

Release notes

For all new features and improvements, see

• What's new in modeling in 2026 (page 13)

• What's new in drawings in 2026 (page 50)

• What's new in connected workflows in 2026 (page 97)

• What's new in interoperability tools in 2026 (page 110)

• What's new in components in 2026 (page 125)

• What's new in Template Editor, templates, and reports in 2026 (page 148)

• What's new in template attributes in 2026 (page 159)

• What's new in advanced options in 2026 (page 161)

Preview features in Tekla Structures 2026

Some of the features in Tekla Structures 2026 are released as Preview features.

A Preview feature is ready for production use, but the feature development
can continue based on the feedback. The Preview features are primarily
intended for evaluation purposes, providing an alternative approach to your
usual workflows. We encourage you to test these features in a normal
business environment and share your feedback. NOTE: a Preview feature
may be enhanced, updated, or discontinued at any time in response to
feedback. Preview features are provided “as is” without any Trimble warranty
or indemnity.

For details about licenses where the Preview features are enabled, see Preview
features in Tekla Structures.

Compatibility

We recommend creating a backup of your model in your current Tekla
Structures version before migrating your project to the latest release.
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This version is not backwards compatible. When you create or save a model
in Tekla Structures 2026, you cannot open it in older versions due to database
differences.

See the Tekla Structures hardware recommendations for information on
supported operating systems.

Tekla Structures Administrator's release notes

For information on managing Tekla Structures settings for other users or for
yourself, see Tekla Structures 2026 administrator's release notes (page 165).

Tekla Structures Localization release notes

For information about new and changed features specific to different localized
environments, see Tekla Structures Localization release notes (page 172).

Tekla Open API release notes

For developers who create custom applications and extensions using the Tekla
Open API, see the Tekla Open API changes in Tekla Structures Open API release
notes in Tekla Developer Center.

Summary of release notes across Tekla Structures versions

The Release notes summary across Tekla Structures versions page provides an
overview to the new features and improvements in Tekla Structures versions
and service packs for Tekla Structures version 2018 and newer. The summary
is available in English only.

List of obsolete advanced options across Tekla Structures versions

The Obsolete advanced options page provides information about the
advanced options that have become obsolete in Tekla Structures in version
2018 and newer.
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2 What's new in modeling in
Tekla Structures 2026

• New clipboard for copying and pasting model and drawing objects

• New way to manage model views: Model views side pane

• Position and arrange model views and drawings in the Tekla Structures
window

• Easy way to set the model background color

• Enhanced model and drawing autosave

• Bind parts to grid levels

• New tool for checking the model for solid errors

• Tekla Launcher - from Preview to an official feature

• New Freeze rebar sets command and other updates in reinforcement
features

• Miscellaneous modeling improvements

2.1 New clipboard for copying and pasting model and
drawing objects
In Tekla Structures 2026, you can efficiently reuse model and drawing content
with the new clipboard functionality, enabling you to easily copy and paste
model objects and drawing objects. Now, each time you copy objects in a
model or in a drawing, the objects are always copied to the clipboard. This
allows you to later paste model objects into the current model or any other
model, or to paste drawing objects into the current drawing or any other
drawing in the same or another model, leading to substantial time savings on
repetitive tasks.
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Copying model objects using the clipboard

Model objects are copied to the clipboard when the following commands are
used on the Edit tab:

• Copy

• Copy --> To another object

• Copy --> To another plane

• Copy --> All content to another object

On the Edit tab, use the Copy --> Copy continuously switch and the Paste
command in conjunction with the above copying commands to copy and paste
model objects.

Note that previously, if you wanted to copy model objects from another model,
you had to use the From another model copying command with Phase
Manager. Now you can simply select the objects in the source model, copy
them to the clipboard, and then paste them into the current or any other
model.

Additionally, you can now copy custom components without the need to
export them. Use the Copy --> To another object command to copy custom
components from one model to another.
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Copying drawing objects using the clipboard

Drawing objects are copied to the clipboard when you use the Copy command
on the Drawing tab.

On the Drawing tab, use the Copy --> Copy continuously switch and the
Paste command in conjunction with the Copy command to copy and paste
drawing objects.
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Controlling clipboard copying

• When the Copy continuously checkbox is selected, the selected objects
are copied to the clipboard, and the copy command remains active. You
can insert the copied objects repeatedly into the model, or into the
drawing, or use the Paste command to insert the copied objects from the
clipboard.

• When the Copy continuously checkbox is cleared, the selected objects are
copied to the clipboard and the copy command is interrupted. Use the
Paste command to insert the copied objects into the same model or into
another model, or into the current drawing or any other drawing in the
same or another model.

The last copied objects always remain on the clipboard, and you can later use
the Paste command to insert the objects from the clipboard.

Keyboard shortcuts

Use the keyboard shortcuts Ctrl+C and Ctrl+V for quick copying and pasting
from the clipboard.

Notes and limitations

• The model and drawing objects that you want to copy using the clipboard
to another model have to be saved in the source model before starting the
Copy command.

• If the source model objects or drawing objects that have been copied to
the clipboard are modified in the model or in the drawing, the changes
will also be updated in the clipboard. Therefore, when you start the Paste
command, you will not get the object you copied originally, but the latest
version of the object.
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• Clipboard is not supported for the following commands:

• Copy --> Linear

• Copy --> Rotate

• Copy --> Mirror

• Copying to and pasting from the clipboard only work with specific drawing
object types. The supported objects are:

• 2D library details

• lines

• polylines

• rectangles

• polygons

• circles

• arcs

• insulations

• clouds

• symbols

• texts

• embedded text files

• embedded DWG and DXF files

• embedded images

• revision marks

• section marks

• detail marks

• weld marks

• You cannot use clipboard copying for the following drawing objects:

• associative annotations: associative notes, part marks, bolt marks, rebar
marks, and so on

• level marks

• drawing views

• templates

• drawing layouts

• Copying of symbols and embedded images, DWGs/DXFs, and text files
in drawings: Currently, Tekla Structures attempts to copy a file into a
destination folder only if it is originally located in the model folder. If the
file is located in any other folder, including shared environment or firm/
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project folders, it will not be copied. Objects located in shared folders are
intended to be shared, not copied.

• When copying sketch objects between drawing views and drawings,
consider the XS_SCALE_COPIED_OR_MOVED_OBJECTS_IN_DRAWINGS
advanced option. This advanced option automatically adjusts the
dimensions of sketch objects to match the scale of the target view.

TTSD-72476

If you are a Tekla Structures administrator
If you manage Tekla Structures settings for other users, update customized
settings for users.

Update ribbons for clipboard for copying and pasting model and drawing
objects

If you have customized the ribbons, update your customized ribbon for
changes to the copy commands.

1. On the Edit tab of the modeling ribbon, add a new drop-down for the
Copy commands:

• Add ribbon item: Split button

• Command: Edit.Copy
• Appearance: Command: Scalable icon

• Text: Command: Full text

2. Move the existing Copy button to be the first item below the new Copy
drop-down.

3. Move these existing buttons from the Copy special drop-down below the
Copy button:

• Linear

• Mirror

• Rotate

4. Add a horizontal separator below the Rotate button:

• Add ribbon item: Separator

• Appearance: Orientation: Horizontal

5. Move these existing buttons from the Copy special drop-down below the
separator:

• To another object

• All content to another object

• To another plane
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• From another model

6. Delete the empty Copy special drop-down.

7. Add a horizontal separator below the From another model button:

• Add ribbon item: Separator

• Appearance: Orientation: Horizontal

8. Below the separator, add the new Copy continuously checkbox.

• Add ribbon item: Check button

• Command: Edit.Copy.ToggleRepeatPaste
• Appearance: Command: Scalable icon

• Text: Command: Short text

9. On the Drawing tab of the drawing ribbon, add a horizontal separator
below the existing Mirror command:

• Add ribbon item: Separator

• Appearance: Orientation: Horizontal

10. Below the separator, add the new Copy continuously checkbox.

• Add ribbon item: Check button

• Command: Edit.Copy.ToggleRepeatPaste
• Appearance: Command: Scalable icon

• Text: Command: Short text

11. Save the changes.

The new ribbon configuration file is saved
to ..\Users\<username>\AppData\Local\Trimble\Tekla
Structures\2026.0\UI\Ribbons.

12. Move the file to the Ribbons sub-folder in a folder that is in the
XS_SYSTEM path.

2.2 New way to manage model views: Model views side
pane
In Tekla Structures 2026, you can quickly organize and manage a large
number of model views in the Model views side pane window. The new
side pane makes it easy to manage and navigate all model views flexibly but
in a controlled manner, and to create general arrangement drawings of the
selected model views.
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The new Model views side pane window replaces the previously used Views
dialog.

If the Model views window is not open, click the  button in the side pane.
The Model views side pane window opens on the left side of the screen and
lists all the views of that model. You can organize the model views in separate
folders, preview the views without opening them, and, if the model has been
shared with Tekla Model Sharing, check which views have been shared and
which are your personal views.
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You can, for example, work with the following way in the new Model views
side pane window.
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To Do this
Open or close the
selected view

Open or close all views
in a folder

• Right-click a view and select Open view or
Close view.

• Right-click a folder or select Open all views in
folder or Close all views in folder.

You can have up to nine views open at the same
time.

To open multiple views, use the Shift and Ctrl keys
when you select views.

Rename a view

Delete a view

• Right-click a view and select Rename.

• Right-click a view and select Delete.
Use the indicators to
quickly check the status
of the view

•

 the view is the currently active view.

•
 the view is currently open.

•
 the view is a temporary view. Rename the

view to make it a permanent view. Temporary
views have a default name in parentheses.

•
 the view is shared in Tekla Model Sharing.

Bring a selected view to
the front on top of the
views

Right-click a view and select Bring to front.

Alternatively, double-click a view in the side pane
to bring it to the front as the topmost of all visible
views.

Switch between the list
view and the thumbnail
view

Click  to switch between the list view and
the thumbnail view.

The thumbnail view shows a preview of each view.
Thumbnail is visible only if you have opened the
view. If a view has never been opened, it does not
have a thumbnail.

Open the Quick access
folder

The Quick access folder displays all open and
temporary views, and those views that you have
marked as favorites.
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To Do this
Add a view to favorites Right-click a view and select Add to Favorites.

The view is then added to the Favorites folder
under Quick access.

Use the Search box Use the Search box to find specific views.
Create a new folder Right-click and select New folder to create your

own folders where you can organize your views.
You can also have subfolders.

Alternatively, create a new folder by clicking .
Move a view to another
folder

Drag the selected view to a suitable folder.

Alternatively, right-click a view and select Cut. Go
to another folder, right-click, and select Paste.

Copy a view to another
folder

Right-click a view and select Copy. Go to another
folder, right-click, and select Paste.

Open view properties Right-click a view and select Properties. The View
properties dialog opens.

Create drawings • If you have selected one view and want to
create a general arrangement drawing of the
selected view, select Create GA drawing.

• If you have selected several views and want to
create general arrangement drawings for each
selected view, select Create GA drawing for
each selected view.

• If you have selected several views and want
to create a general arrangement drawing
that includes all the views, select Create GA
drawing containing selected views.

Alternatively, create an empty drawing, or define

the drawing properties by clicking .

To open the created drawing, click the Drawing
created. Click here to open the drawing. button.
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To Do this
If the model has been
shared using Tekla
Model Sharing

Personal views and shared views are organized in
separate folders.

Views in the Personal views folder are not shared,
whereas the views in the Shared views are shared
with other Tekla Model Sharing users.

• To share a view with Tekla Model Sharing, right-
click a view and select Share. If you select
multiple views, you can share all of them at
once.

Alternatively, drag the selected views to the
Shared views folder.

• To remove a view from being shared, right-
click a shared view and select Remove from
sharing.

Alternatively, drag the selected views to the
Personal views folder.

Note that the Share option is available only if the
model has been shared using Tekla Model Sharing.

Shared views are moved to the Shared views

folder, marked as shared , and shared the
next time when the model is written out to the
sharing service. The folder structure of the Shared
views folder is shared as well.

TTSD-69570

If you are a Tekla Structures administrator
If you manage Tekla Structures settings for other users, update customized
settings for users.

Update ribbons for changes to model views

If you have customized the ribbons, update your customized ribbon to replace
the previous View list button with a new Model views button.
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1. On the View tab of the modeling ribbon, add the new Model views
button.

• Add ribbon item: Simple button

• Command: Views.ModelViews
• Appearance: Command: Scalable icon

• Text: Command: Short text

2. Remove the previous View list button.

3. On the Views tab of the drawing ribbon, add the new Model views button
to the Model views drop-down.

• Add ribbon item: Simple button

• Command: Views.ModelViews
• Appearance: Command: Scalable icon

• Text: Command: Short text

4. Remove the previous Model view list button.

5. Save the changes.

The new ribbon configuration file is saved
to C:\Users\<username>\AppData\Local\Trimble\Tekla
Structures\2026.0\UI\Ribbons.

6. Move the file to the Ribbons sub-folder in a folder that is in the
XS_SYSTEM path.

2.3 Position and arrange model views and drawings in
the Tekla Structures window
Model views and drawings can now be easily positioned and arranged around
the Tekla Structures window using different docking zones. Previously, the
model views and drawings had to be manually resized and positioned to a
suitable layout, which was inefficient and time consuming. Now the docked
model views and docked drawings react to each other, resizing and adjusting
to maintain a clean and organized layout.

To dock a model view or a drawing, drag the model view or drawing by its
title bar close to the Tekla Structures window edge in the direction where
you want to dock it. As you drag and move closer to the window edge, blue
highlighting shows where you can dock the model view or the drawing. There
are altogether nine predefined docking zones around the Tekla Structures
window. Note that you can only dock the model views or drawings to the
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predefined docking zones; the model views or drawings do not dynamically
identify empty areas.

These docked positions for model views and drawings are saved and restored
the next time you open the model.

Model views and drawings automatically resize and reposition themselves to
fit the screen and avoid overlapping with each other or any open side pane
windows. The dynamic adjustment ensures that when you stretch one view,
the others are automatically resized and adjusted, even if the whole Tekla
Structures window is resized.

If you undock a model view or drawing, it reverts to its original size and
position.
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The model view you are working on is highlighted to ensure that you are
working in the correct view.

TTSD-70671
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2.4 Easy way to set the model background color
In Tekla Structures 2026, you can quickly change the model background color
to customize your workspace appearance.

On the View tab, click Color theme and select one of the options:

Option Example
For white background in
all model views: Light

The grid color is adjusted according to the
background color.

Grid line labels are set to black.
For black background in
all model views: Dark

The grid color is adjusted according to the
background color.

Grid line labels are set to white.
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Option Example
For the default gradient
background in all model
views: Tekla default

The grid color is adjusted according to the
background color.

Grid line labels are set to black.
For your own
background color in
all open model views:
Advanced

This opens the Advanced options dialog, where
you can set your own background color by using
RGB values on a scale from 0.0 to 1.0

Note that changing the color theme affects only the model background color,
not the colors in the user interface.

TTSD-69544

If you are a Tekla Structures administrator
If you manage Tekla Structures settings for other users, update customized
settings for users.

Update the ribbon for background color

If you have customized the ribbon, update your customized ribbon to add
a new button group for Color theme and buttons for the background color
options.

1. On the View tab, add a drop-down button for the Color theme button
group:

• Add ribbon item: Drop-down button

• Icon: resource:Brush.CommandGallery.Views.BackgroundLight

• Text: translation:Commands.Views.ColorTheme
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2. Under the Color theme drop-down, add buttons for the Light, Dark, and
Tekla default color themes:

• Add ribbon item: Simple button

• Command: Views.BackgroundLight, Views.BackgroundDark, and
Views.BackgroundDefault

• Appearance: Command: Scalable icon

• Text: Command: Full text

3. Add a horizontal separator below the color theme buttons:

• Add ribbon item: Separator

• Appearance: Orientation: Horizontal

4. Below the separator, add the new Advanced button:

• Add ribbon item: Simple button

• Command: Views.BackgroundAdvanced
• Appearance: Command: Scalable icon

• Text: Command: Full text

5. Save the changes.

The new ribbon configuration file is saved
to ..\Users\<username>\AppData\Local\Trimble\Tekla
Structures\2026.0\UI\Ribbons.

6. Move the file to the Ribbons sub-folder in a folder that is in the
XS_SYSTEM path.

2.5 Enhanced model and drawing autosave
The autosave functionality for drawings has been significantly enhanced to
minimize work loss during editing in Tekla Structures 2026. Drawings are
now automatically saved at defined intervals. When you open an autosaved
model, you now receive more information about the model and the autosaved
drawing, and you are able to restore your model and drawing.

Minimize loss of drawing editing work with drawing
autosave
Editing drawings, especially general arrangement drawings, may take some
time. To ensure that the editing work is not lost when an application error
occurs, the drawing autosave was improved. Now the autosave for drawings is
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also triggered automatically at an interval defined in the Options dialog on the
General page.

Previously, autosaving was done automatically for the model only, either at
defined intervals or after you had created a defined number of drawings.
Autosaving after creating a certain number of drawings is still available as a
safety measure.

TTSD-72435, TTSD-73273, TTSD-72508

How model and drawing autosave works
During autosave, the model is saved in the model \autosave folder as
before, for example, in C:\TeklaStructuresModels\autosave\House. The
drawing is saved in the model autosave folder in the \drawings subfolder, for
example, C:\TeklaStructuresModels\autosave\House\drawings.

There will always be at least one model autosave when a drawing is
autosaved. Subsequent drawing autosaves will not trigger a model autosave
unless there are model modifications.

When you close a drawing normally (with or without saving), the
drawing autosave file is deleted. Additionally, when you save a model,
both model and drawing autosaves are deleted. This ensures that
there is only one autosaved drawing at a time. When you close
the model, model autosaves are deleted unless the advanced option
XS_KEEP_AUTOSAVE_FILES_ON_EXIT_WHEN_NOT_SAVING is set to TRUE.

Restoring autosaved model and drawing
When a Tekla Structures application error occurs, opening the active model
prompts you to open either the manually or automatically saved model
version, as before. The dialog has been improved to include the following
information:

• The name of the autosaved drawing, if any

• The path to the autosaved version of the model and the autosaving time

• The path to the last manually saved version of the model and the saving
time
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If you select Autosaved to restore the autosaved version of the model, and
there is an autosaved drawing, Tekla Structures opens the autosaved model
and the drawing automatically.

When you open the drawing, a notification appears indicating that the
autosaved drawing has been opened and saved. Check the drawing and
choose if you want to keep or discard that version. If you do not want to
restore the autosaved drawing, you can open the Drawing versions feature
and select a previous version and save that instead. If you want to keep it, you
should save both the drawing and the model as soon as possible.

You can access manually saved drawing versions using the Drawing versions
feature in Document manager. You are required to exit the autosaved
drawing with a save, which adds the autosaved drawing as a new version.
Then you can switch between all existing drawing versions freely.

What's new in modeling in Tekla Structures 2026 32 Enhanced model and drawing autosave



2.6 Bind parts to grid levels
You can now bind steel and concrete parts to various z-direction elevations
that are taken from the project grids. During the early conceptual phase,
frequent changes in part levels along the z-direction can be time-consuming
to adjust manually. By linking parts directly to defined grid elevations, manual
work and errors are minimized and the accuracy in the modeling process
is improved. If there are any changes in the part levels in the z-direction,
all bound parts update to match the new z-direction elevation. This ensures
that any changes to grid levels or story elevations, if you are using building
hierarchy, automatically reposition the bound parts.

For example, if the z-coordinate increases by 1 meter, the height of the bound
object is automatically adjusted by the same amount. Bindings can be further
refined with positive or negative offset values that correspond to the bound
levels. Additionally, you have the flexibility to adjust, add, remove, or rename
levels as needed. To find the bound parts in a model, you can create a filter or
a report, and once the bindings are not needed anymore, you can unbind all
bound parts at once.

Parts are bound to grid levels in the following ways:

Part How the part is bound
Columns and walls Bind to grid levels from the top and bottom part

face.
Beams and polybeams Bind to grid levels from the start and end points of

the part.

Note: When start and end points of a polybeam
are bound, any intermediate points scale
proportionally to maintain the relative geometry of
the polybeam.

Slabs, footings, and
plates

Bind to a single level from the top face only.

To bind parts to grid levels:

1. Start by ensuring your grids are suitably named.

This will help you to identify different grids and make it easier to select the
correct level for a part in question.

a. In the grid properties, go to the Name property to name the grid.

When a new grid is created, the grids get automatically named to
GRID, GRID 1, and so on.

b. Change the current grid name if needed.

2. Bind a part to a selected grid level.

a. Select a part in the model that you want to bind to a grid level.
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b. In the properties of the selected part, go to the Bind to levels
property.

c. Select the grid level to which you want to bind the selected part.

You can bind the selected part fully or partially. If you bind the
part only partially, leave the other end unbound. This allows you to
manually set the position value for that end.

• For a column or wall, you can bind either the top or bottom part
face using the Top level and Bottom level options.

• For a beam or polybeam, you can bind either the start or end
point using the Start level and End level options.

For polybeams:

• If you enter only one point, the second point will either stay
unbound if left empty, or be set based on the picked point's
coordinate.

• When the polybeam start and end points are bound, any
intermediate points scale proportionally to maintain the
relative geometry of the polybeam.

• When you have a flat polybeam, where the start and end level
are the same, the polybeam stays flat even when the levels
change, and all the intermediate points move together by the
same amount.
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• For a plate, a slab, or a footing, you can only bind the top face to a
single level using the Level option.

d. If needed, you can enter a positive or negative offset value to refine
the position of the bound end relative to the level.

e. Click Modify to set the binding.

If you resize or reshape the bound parts

If you later use direct modification to modify the part, the part will
not be unbound from its level. Instead, changes made using direct
modification or changing the part profile adjust the offset value
relative to the bound level.

If you copy or move the bound parts

• If you move a part and its new z-coordinates align with the z-level
grid, its top and bottom levels are updated to these new z-levels.
This only works if the new level difference matches the original
difference.

• If only one end of the part, either top or bottom, aligns with the
new z-level, that end connects to the new level and the other end
is unbound.

• If the part is positioned between levels and the new level
difference does not match the original, the part loses its binding
and returns to its original position.

• If the part moves to a position without any z-level match, the part
loses its binding and returns to its default position.

Note that building hierarchy works the same way when you
change a building story's height.

3. Once the objects are bound to levels, you can use the new
BIND_TO_LEVELS template attribute in reports to report on all bound
objects in your model.

To filter parts based on whether or not they are bound to levels, in the
Object group - Selection filter, use the new property Bind to levels in
the Part category.
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4. When you do not need the bindings anymore, you can remove the
bindings. Select an empty value in the list of levels in the property pane,
or click Edit --> Parametric modeling and select Unbind all or Unbind
selected objects from levels.

TTSD-69544

If you are a Tekla Structures administrator
If you manage Tekla Structures settings for other users, update customized
settings for users.

Update the ribbon for unbind objects from levels

If you have customized the ribbon, update your customized ribbon to add
buttons for Unbind all and Unbind selected objects from levels commands.

1. On the Edit tab, under Parametric modeling, add the new Unbind all
and Unbind selected objects from levels buttons.

• Add ribbon item: Simple button

• Command: Modeling.UnbindAllObjects and Modeling
UnbindSelectedObjects.

• Appearance: Command: Scalable icon

• Text: Command: Full text
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2. Save the changes.

The new ribbon configuration file is saved
to ..\Users\<username>\AppData\Local\Trimble\Tekla
Structures\2026.0\UI\Ribbons.

3. Move the file to the Ribbons sub-folder in a folder that is in the
XS_SYSTEM path.

Update the property pane for bind objects to levels

If you have customized the property pane, update your customized property
pane to add a new property group Bind to levels and a new property Name.

Add the Bind to levels property group to the property pane layout for the
following model objects:

• ConcreteSlab
• ConcreteColumn
• ConcreteBeam
• ConcretePanel
• PadFooting
• StripFooting
• SteelColumn
• SteelBeam
• ContourPlate
Add the Name property to the property pane layout for the following objects:

• RectangularGrid
• RadialGrid
1. In the PropertyTemplates.xml file, add a new property group for Bind

to levels below the Position property group for each above mentioned
object type. Add the following:

<PropertyGroup Name="BindToLevels" 
Label="translation:albl_Bind_to_levels" 
Tooltip="translation:albl_Bind_to_levels">
      <Property Name="Property.BindToLevel"/>
</PropertyGroup>
2. In the PropertyTemplates.xml file, add the Name property above the

UDAs property for each above mentioned object. Add the following:

<Property Name="Property.Grid.Name" />
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2.7 New tool for checking the model for solid errors
When working with Tekla Structures, you may encounter errors in solid objects
in the model. You can now use the new Solid checker tool to check the model
for solid errors.

For example, when working with cast-in-place concrete parts, you should
inspect the resulting pour objects regularly before starting the detailing
process and before creating drawings and reports. Errors in solid pour objects
can result in incorrect volumes, for example.

To start the Solid checker, go to the File menu, and click Diagnose & repair
--> Check solids. In the Solid checker dialog, click the Check solids button to
generate a list of solid errors. Then you can select errors on the list to highlight
the related objects in the model and to zoom in on them. You can also click
Ignore error on an error row to hide the error from the list. After working on
the errors in the model, click Check solids again to see how the situation has
changed.

TTSD-71960

2.8 Tekla Launcher - from Preview to an official feature
Tekla Launcher was introduced as a preview feature in Tekla Structures 2025.
Now in Tekla Structures 2026, Tekla Launcher has transitioned to an official
feature.

Tekla Launcher remains an alternative method to start Tekla Structures and to
open and create models.

In Tekla Structures 2026, in addition to having the official feature status, Tekla
Launcher has undergone other major improvements.

• Tekla Launcher is a standalone app

Tekla Launcher is now a standalone app, allowing you to open models with
the relevant Tekla Structures version based on the model information. The
standalone Tekla Launcher will be the starting point for all Tekla Structures
versions.

• Model creation using all installed Tekla Structures versions

The updated Tekla Launcher allows the creation of models with all installed
versions of Tekla Structures, although there are some limitations with older
Tekla Structures versions. Older versions of Tekla Structures might not be
able to fully process some of the new features.

• Tekla Launcher supports project settings that have been created in
the Project Settings Management Console

The updated Tekla Launcher supports project settings and company
collections that have been created in the Project Settings Management
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Console, which is a web-based tool that lets you manage your project
settings, environments, and other project files in the cloud.

Once you have created your settings in the Project Settings Management
Console, Tekla Launcher automatically pulls the published settings from
the cloud, and you can create new models where everyone uses the exact
same project settings.

Project Settings Management Console is a preview feature, and all
the features supporting Project Settings Management Console have the
preview status in Tekla Launcher.

• Tekla Launcher compatibility

Tekla Structures maintained versions can use project settings created in the
Project Settings Management Console, but with some limitations.

TTSD-71341

2.9 New Freeze rebar sets command and other updates
in reinforcement features
Tekla Structures 2026 introduces new commands and settings that you can
use to prevent automatic adjustments and unwanted changes in rebar sets
that have already been detailed or fabricated. Now you can also split rebar
sets the same way as rebar groups. Bar layer offsets of rebar sets and labels
for rebar objects can be shown in model views.

Freeze and unfreeze rebar sets
You can now freeze rebar sets so that they do not change when the
surrounding model is modified. This is useful, for example, when the bars
have already been fabricated.

The new Freeze rebar sets and Unfreeze rebar sets commands are available
on the Rebar ribbon tab, under More:
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Alternatively, when you select rebar sets in the model, and right-click, you can
use the Freeze/Unfreeze command from the context menu, and then select
Freeze or Unfreeze.

In model views, frozen rebar sets, leg faces, and leg surfaces are indicated with

a snowflake symbol  next to the bar layer number when you select rebar
sets and when the leg faces are visible.

When frozen rebar sets are selected, the number of frozen rebar sets is shown
in the property pane header. For example: Rebar set (3 selected, 1 locked, 1
frozen)

You can also use the IS_FROZEN template attribute in reports to check if
a rebar set is frozen or not, or to filter frozen rebar sets, for example. The
attribute shows 0 if the rebar set is not frozen, 1 if the rebar set is frozen, and
2 if the rebar set is partially frozen, meaning that some of its leg faces are
frozen and some are not.

TTSD-70398, TTSD-73525, TTSD-71662, TTSD-73534, TTSD-70352
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New bar placement and layering settings for rebar sets
There is a new Bar placement section in the rebar set property pane with the
following settings:

• Automatic layering

This setting is also available in the Bar leg placement section in the leg
face and leg surface properties.

When a rebar set, leg face, or leg surface is frozen, Automatic layering is
off.

• Layer number has been moved from the Special section to this new
section.

When a rebar set, leg face, or leg surface is frozen, Layer number is not
available, but may change unless you lock the rebar set.

• Offsets

When a rebar set is frozen, the At depth, Start, and End offsets are
available.

• Adaptivity

When you freeze a rebar set, Adaptivity is set to Off, but you can manually
select another option.

TTSD-71781, TTSD-71895

New offset types for leg faces and leg surfaces
In addition to the layering settings Automatic layering and Layer number,
the section renamed from Attributes to Bar leg placement in the leg face
and leg surface properties now contains new offset types. The new Offset
settings replace the previous Additional offset property. The offset types are:

• From concrete cover

This option works the same way as the previous Additional offset
property and is only available when Automatic layering is on.

• From previous layer

This option is only available when Automatic layering is on.

• From leg face to bar edge

When freezing a rebar set that uses the concrete cover value of the parent
concrete part, the Offset setting is changed to this option. The leg face or
leg surface is located on the face of the part.

• From leg face to bar center

When freezing a rebar set that does not use the concrete cover value of the
parent concrete part, the Offset setting is changed to this option. The leg
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face is not on the face of the part, but is either entirely inside or outside the
part.

Using the Inquire rebar set layers command now also reports the new offset
types.

TTSD-71780, TTSD-71895, TTSD-73535

Offset values of rebar sets in model views
The overall offset value can now be displayed on each rebar set leg face
and leg surface in model views, next to the layer number. The offset is
comprised of the concrete cover, the bar layering offset, and any additional
offset defined. This offset is shown when the Rebar dimensions and Leg
faces checkboxes are selected under Visibility on the Rebar ribbon tab.

TTSD-73112

Split rebar sets
You can now use the Split command to split rebar sets. Previously, you could
split parts, single reinforcing bars, and normal and tapered reinforcing bar
groups.

You may need to split a rebar set, for example, when you want to add only a
portion of it into a rebar assembly.

To split a rebar set, go to the Edit tab on the ribbon and click Split. Select the
rebar set, and pick two points for the splitting line.

Rebar sets with leg faces can be split in any direction.

Limitations:

• Splitting only works with rebar sets that have one or two straight
guidelines. If you try to split a rebar set that has more than two guidelines
or a curved guideline, Tekla Structures shows a message saying "The object
cannot be split in this position".

• Rebar set leg surfaces cannot be cut. If a rebar set has leg surfaces,
splitting only works perpendicular to the guideline (=parallel to the bars).

TTSD-69992

Labels for reinforcement objects in model views
Similarly to part labels, you can now show labels for reinforcement objects in
model views. There is a new section, Rebar label, on the Advanced tab in
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the Display dialog. There you can define the contents of the rebar labels, and
whether they are shown for all or the selected reinforcement objects:

TTSD-69110

Other reinforcement changes
• In the Auto splitter component, a new splicing symmetry option

 is now available that allows splitting reinforcing
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bars so that all resulting bars have equal length. This length is as close to
the maximum allowed length as possible.

TSAC-8871

• The following template attributes are now available for reinforcement
objects with the REBAR and SINGLE_REBAR content types and in rebar
marks:

TOP_LEVEL, TOP_LEVEL_GLOBAL, TOP_LEVEL_BASEPOINT,
TOP_LEVEL_PROJECT,

BOTTOM_LEVEL, BOTTOM_LEVEL_GLOBAL, BOTTOM_LEVEL_BASEPOINT,
BOTTOM_LEVEL_PROJECT
TTSD-69106

• The following advanced options have been hidden from the Tekla
Structures user interface:

• XS_REBARSET_SHOW_LEGFACES
• XS_REBARSET_SHOW_GUIDELINES
• XS_REBARSET_SHOW_PROPERTY_MODIFIERS
• XS_REBARSET_SHOW_SPLITTERS
• XS_REBARSET_SHOW_END_DETAIL_MODIFIERS
• XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_REBARS
• XS_REBARSET_COLOR_BARGROUPS
Instead of these advanced options, you can use the Rebar --> Visibility
commands on the ribbon, or the keyboard shortcuts Alt+1...7.

TTSD-74620

• The Rebar sequence numbering macro that was available in the
Applications & components catalog has been removed. Since Tekla
Structures 2025, you have been able to assign reinforcement sequence
numbers using the regular numbering commands on the ribbon.

TTSD-72545

If you are a Tekla Structures administrator
If you manage Tekla Structures settings for other users, update customized
settings for users.

Update the ribbon for Freeze rebar sets and Unfreeze rebar sets

If you have customized the ribbon, update your customized ribbon to add
buttons for the new Freeze rebar sets and Unfreeze rebar sets commands.
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1. On the Rebar ribbon tab under More, add new Freeze rebar sets and
Unfreeze rebar sets buttons.

• Add ribbon item: Simple button

• Command: Reinforcement.Freeze and
Reinforcement.Unfreeze

• Appearance: Command: Scalable icon

• Text: Command: Full text

2. Save the changes.

The new ribbon configuration file is saved
to C:\Users\<username>\AppData\Local\Trimble\Tekla
Structures\2026.0\UI\Ribbons.

3. Move the file to the Ribbons sub-folder in a folder that is in the
XS_SYSTEM path.

Update the property pane for automatic layering setting for rebar sets

If you have customized the property pane, update your customized property
pane to update the properties pane for Rebar set leg face and Rebar set leg
surface.

Make these updates in the PropertyTemplates.xml file in the
PropertyTemplate Type="RebarSet.LegFace" and PropertyTemplate
Type="RebarLegSurfaceObject" property templates:

1. Replace the previous Attributes property group with the new Bar leg
placement property group.

Before:

<PropertyGroup Name="Attributes" Label="translation:albl_Attributes" 
Tooltip="translation:albl_Attributes">

After:

<PropertyGroup Name="BarLegPlacement" 
Label="translation:albl_Bar_leg_placement" 
Tooltip="translation:albl_Bar_leg_placement">
2. Add a new property for Automatic layering as the first item under the

new Bar leg placement property group:

3.<Property Name="Property.LegFace.AutomaticLayering" />

2.10 Miscellaneous modeling improvements
Tekla Structures 2026 provides improvements in modeling functionalities.
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Changes in log locations
In Tekla Structures 2026, logging has been improved.

All logs, such as ClashCheck.log and numberinghistory.log, are now
located either in the model folder under the \logs folder, or in the local
application data folder at %LocalAppdata%\Trimble\Tekla Structures\
%Version%\Logs. This means your logs are in a more consistent and
predictable location.

Additionally, Tekla Structures session history log files and error log files
have been moved to the local application data folder at %LocalAppdata%
\Trimble\Tekla Structures\%Version%\Logs or to the path specified by
the advanced option XS_LOGPATH.

The files have also been renamed to the format TeklaStructures-
<process id>.log for the session log and TeklaStructures-<process
id>.err for the error log. The log entries for the last five Tekla Structures
sessions are stored in the folder.

Additionally:

• Tekla Structures now automatically manages your log files. When you start
Tekla Structures or open a model, older logs will be cleaned up, ensuring
you always have the most relevant information without clutter.

• Log messages now follow a consistent format, making them easier to read
and understand if you ever need to review them. This also helps our
support team quickly pinpoint any issues.

• There is new API support for developers building extensions and plugins.
Tekla Structures now offers a dedicated Tekla.Structures.Logging
SDK. This SDK provides a consistent and official way to implement logging
within your applications, ensuring that logs from your tools integrate with
Tekla Structures new logging system.

• See also Location change for drawing, cloning, and printing logs (page 96).

TTSD-69076, TTSD-69882

Numbering preview: review identical objects individually
The Numbering preview dialog now has a new separate table where you can
show, select, and review identical objects that are treated in the same way in
numbering. The new Individual objects table shows all the individual objects
that you have selected in the main table in the Numbering preview dialog.

This improvement was already introduced in Tekla Structures 2025 SP4.

TTSD-69579
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Design group numbering compares gross length and finish
In the Design group numbering application, you can now compare parts
based on their gross length and finish.

TSAC-9167

Selection switches: activate or deactivate selected switches
using the Ctrl key
You can now activate or deactivate selection switches one by one. Hold down
the Ctrl key and click the selected switches.

This improvement was already introduced in Tekla Structures 2025 SP1.

TTSD-69048

Pour solids created in local coordinates
Pour solids, including continuous structures and pour objects created by pour
breaks and cuts, are now created using local coordinates instead of global
coordinates. The cut or split part solids are generated in local coordinates and
use instancing in various operations. This approach enhances the numerical
accuracy of solid creation for pours and accelerates operations because the
instanced part solids created in local coordinates can be reused in many
operations.

TTSD-73796

Improved triangulation of slab top and bottom faces
An issue was fixed where slabs with Dz1 or Dz2 offsets at corner chamfers
could produce incorrect solid geometry due to mismatched triangulation
between the top and bottom faces. This inconsistency led to inaccurate
geometry, which could cascade to downstream processes, including volume
calculation and pour unit generation. The triangulation of the faces is
now mirrored consistently, ensuring reliable geometry and accurate volume
computation.

This improvement was already introduced in Tekla Structures 2025 SP3.

TTSD-47057
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Custom component fixes
• Previously, it was not possible to create a custom seam component with

points picked in the main part's x-direction without any secondary parts.
This has now been fixed.

• Previously, certain custom components with an array of objects did not
work correctly. Specifically, inserting or modifying such a component
increased the number of objects in the array, causing the operation to
become slower and slower. Additionally, the Get or Modify operations in
the dialog did not work. This has now been fixed.

These improvements were already introduced in Tekla Structures 2025 SP5.

TTSD-62177, TTSD-56963, TTSD-58139

Improvements in filterable drop-down lists
• Searching for settings files or property files in the drop-down lists in the

property pane and in several dialogs has now been improved: typing
anything that matches any part of the file name is considered as a search
match.

TTSD-67211, TTSD-67221, TTSD-67240, TTSD-67294

• The filterable drop-down lists in the property pane and in several dialogs
now allow you to select an item with the Enter key if there is only one item
available in the list.

TTSD-67782, TTSD-68956, TTSD-68975, TTSD-69070

These improvements were already introduced in Tekla Structures 2025 SP2.

Improvement in uploading larger files in Support tool
Previously, the packaging functionality in the Support tool was not able to
handle files larger than 2 GB. This issue has now been fixed, and it is possible
to upload files up to 5 GB in size.

This improvement was already introduced in Tekla Structures 2025 SP1.

TTSD-69474

Tekla Model Sharing now included in Tekla Open API
Tekla Model Sharing management operations can now be done through Tekla
Open API.

Specific Tekla Open API operations include:

• Start sharing a model
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• Browse and join a model

• Invite users to join a model

• Perform a read in

• Perform a write out

• Reserve the next write out

• Exclude a model from Tekla Model Sharing

TTSD-71030
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3 What's new in drawings in Tekla
Structures 2026

• New in AI Cloud Fabrication drawings

• Enhancements in drawing cloning

• Review and change section view associativity

• Edit the model and general arrangement drawing together

• Intuitive 2D sketching, editing, and annotations in drawings

• Improvements in reinforcement in drawings

• Enhancements in drawing colors and lines

• Other improvements in drawings

3.1 New in AI Cloud Fabrication drawings
In Tekla Structures 2026, reduce the time and expertise needed to create
fabrication drawings with AI-assisted template selection and improved cloning
and associativity.

First released as a preview feature in Tekla Structures 2025, the service has
been improved based on the feedback. Additionally, the method for finding
the best matching template has been enhanced, and now it more likely
suggests a match that is more similar to the target assembly. While the new AI
model improves template matching from the cloud libraries, a human-in-the-
loop step helps fine-tune the AI suggestions. The updated interface provides
a clear template preview, top three AI-based matches, and options to clone or
create from settings.

To further enhance drawing output quality, cloning has been improved with
more reliable placement of annotations, dimensions, and views, avoiding
issues such as stiffeners being dimensioned as connection plates. You can
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also associate section views (page 61) with objects, helping keep the drawings
consistent after cloning or model updates.

Many improvements have also been delivered to AI Cloud Fabrication
drawings in Tekla Structures version 2025 through the service packs.

Improvements in Tekla Structures 2026

Enhanced template matching

In Tekla Structures 2026, the method for identifying the best matching
templates has been thoroughly revamped. If drawings exist in a library for
assemblies or cast units similar to the selected ones, the new method is
optimized to locate and suggest these drawings as templates. Additionally, the
search time for the best matching templates has been significantly shortened.
The method now suggests multiple template candidates, offering up to three
top choices based on library size and candidate quality.

TTSD-72442, TTSD-71980

Improved drawing upload

• Earlier, you could not re-upload drawings manually from Document

manager using the  plus button when the drawing was modified or
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when you were uploading from a newer Tekla Structures version. This issue
has now been fixed, and re-uploading succeeds.

TTSD-74129

• Previously, the drawing upload could start with a significant delay. This
issue has now been fixed.

TTSD-74599

Improved cloning results

• Cloning results have improved for drawings created using the AI Cloud
Fabrication drawings feature when source drawings have been uploaded
from Tekla Structures 2025 SP2 or newer into a collection. Better cloning
results can be seen with elements such as dimensioning, marks, and
section views.

TTSD-70220

• There are also improvements in drawing cloning that might affect the
creation quality of AI Cloud Fabrication drawings, for example, cloning is
now faster and it now works more reliably with main parts that are not very
similar. Cloning improvements are mentioned separately in Enhancements
in drawing cloning (page 54).

Improvements in Tekla Structures 2025 service packs
For a complete list on all improvements and fixes that have been released in
the Tekla Structures 2025 service packs, see the following release notes:

Tekla Structures 2025 SP1

Tekla Structures 2025 SP2

Tekla Structures 2025 SP3

Tekla Structures 2025 SP4

Tekla Structures 2025 SP5

Tekla Structures 2025 SP6

Tekla Structures 2025 service pack highlights

The best matching template or its settings file is automatically selected in
the top match library, and you can also change your selections. This provides
greater flexibility and control over the drawing creation process. Previously,
you could only select the library, and the drawing creation was done using the
best matching template or its settings file in the selected library.
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Small and large template preview:
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A single progress bar instead of processing queue messages:

3.2 Enhancements in drawing cloning
In Tekla Structures 2026, cloning has been improved with more reliable
placement of annotations, dimensions, and views.

Better placement of views and dimensions in cloning

Dimension placement

Tekla Structures is now more precise in placing dimension points.
Previously, dimension points could occasionally be placed outside objects,
leading to dimensions being shown to invisible objects. This improvement
ensures that dimension points are always placed only on visible objects.

Before:
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After:

Automatically generated dimensions in cloned drawings, controlled by
XS_INTELLIGENT_CLONING_ADD_DIMENSIONS, are now placed at optimal
distances from the dimensioned objects and other dimensions.

Before:
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After:
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View placement

To ensure that the view placement improvements are applied, the advanced
option XS_DRAWING_UPDATE_VIEW_PLACING must be set to TRUE.

The cloned view placement has been improved for situations where views
are wider or taller than the drawing sheet. Previously, these views would not
move; now, they are adjusted to fit the drawing sheet as much as possible
after being cloned.

Tekla Structures now intelligently places views within drawing frames in cloned
drawings. When using templates (.tpl) for drawing frames, Tekla Structures
attempts to prevent views from overlapping each other.

Before:
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After:
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Section views and section marks

The section view behavior in cloning has been improved for situations where
an assembly has new parts. Now, when new parts are detected, the section
view attempts to resize to fit the parts within its boundary box.

Before:

After:

Independent section marks that are not associated with any objects could
previously be placed quite far from the assembly objects. Independent section
marks are now deleted if they are not placed in the close proximity to a part.

Before:
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After:

TTSD-71091

These improvements were already introduced in Tekla Structures 2025 SP4
release notes.

Other cloning improvements
• You can now validate and control the association of the section views to

objects in fabrication drawings. This enhancement contributes to more
predictable and reliable drawing behavior in view placement, and improves
the quality of cloned and updated drawings. For more information, see
Review and change section view associativity (page 61).
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• The cloning of the drawing dimensions has been improved so that bad
dimension points that could not be fixed and were left pointing at nothing
or far outside the view are now removed.

TTSD-69959

• Cloning of cast units with notches or anchor bolts has been improved.
This can be observed, for example, by more consistent application of
dimensioning rules between source and target cast units.

TTSD-69763

3.3 Review and change section view associativity
In Tekla Structures 2026, you can validate and control the association of the
section views to objects in fabrication drawings. This enhancement contributes
to more predictable and reliable drawing behavior in view placement, and
improves the quality of cloned and updated drawings. At the same time, it
reduces the need to manually correct views in updated or cloned fabrication
drawings.

Previously, incorrect associativity settings could lead to issues with section
views, such as views appearing in unexpected locations or disappearing after
updates or cloning.

• When you create a new section view, Tekla Structures selects the associated
object for the section view automatically and shows it in the associativity
label. The associativity rule list for the section view is displayed at view
creation, and there you can see all possible objects the section view can be
associated with.

If you are satisfied with the object selection, no further action is needed.
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• If you are not satisfied, you can change the currently associated object.
Click another object in the associativity rule list. The selected object is
highlighted in the main view and in the section view.

You can also change the associated object after creating the section view:
Click the section view frame, click the associativity rule list down arrow, and
select another object.

Limitations

• Showing or changing section view associativity is not available in general
arrangement drawings.

3.4 Edit the model and general arrangement drawing
together
Tekla Structures 2026 introduces a new efficient way of working that lets you
modify a model and a general arrangement drawing simultaneously without
having to close the drawing in between.

When working in a general arrangement drawing, you sometimes notice that
adjustments are needed in the model. You might need to modify incorrect
geometries and properties, and add missing parts. Previously, in situations
like these, you had to close the drawing, then edit the model, and reopen
the drawing to see the changes. Now you can work fluently and save time as
you do not need to close and reopen general arrangement drawings during
the design process. The changes you make to the objects in the model are
instantly visible in the drawing. Marks, labels, dimensions, and templates are
updated automatically.

Note that you can use this new way of working only with general arrangement
drawings. You cannot edit the model while having a fabrication drawing open.

What's new in drawings in Tekla Structures 2026 62 Edit the model and general arrangement drawing
together



Select a model view for editing

To edit the model while having the general arrangement drawing open, select
a model view for editing. You can select the model view on the Window ribbon
tab, in the Model views side pane, or from the model if you have many model
views open.

On the Window ribbon tab, you can select to tile the Tekla Structures window
either vertically or horizontally to get both the model and drawing visible at
the same time. When you have both the model view and the drawing open,
switching between the model and the drawing changes the ribbon, property
pane, and toolbars according to the mode that you have currently selected.

You can position and arrange model views and drawing views around the
Tekla Structures window using different docking zones. For more information,
see Position and arrange model views and drawings in the Tekla Structures
window (page 25)

If you want to prevent model editing while having a general arrangement
drawing open, you can set the new XS_ENABLE_MODEL_EDITING_IN_GA
advanced option to FALSE. The default value of the advanced option is TRUE.

Automatic selection between the model and drawing

When working both in the drawing and in the model at the same time, you
need to know which objects are affected by your selections and changes
to ensure that you are working on the correct objects. Automatic selection
between drawing and model objects allows you to easily track the design
process and to easily find the objects in the model and drawing. You can select
individual or multiple objects, or use area selection.

To switch to the desired view in the model or in the drawing, click the middle
mouse button in the view or select the view from the list on the Window
menu. This way the objects you have selected stay selected when switching
between the model and the drawing. If you click the left mouse button in the
view itself, the view will be selected and your original object selection is lost.

Selection in drawing

When you select an object in the drawing, the object is highlighted in the
model. When you switch to the model, the highlighted object is selected. If you
have more than one model view open, the object you select in the drawing is
selected in all the model views.

Selection in model

When you select an object in the model, the object is highlighted in the
drawing. When you switch back to the drawing, the highlighted object is
selected. If the object is visible in multiple views in the same drawing, the
object is selected in all the drawing views.

Highlight selection

You can control the automatic selection in Quick Launch using the Highlight
selection command. By default, the command is selected and the automatic
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selection is enabled. If you do not want to use the automatic selection, clear
the Highlight selection checkbox.

Create a model view from a drawing view

You can create a new temporary model view from a drawing view if you need
a model view that exactly represents the drawing view. Creating a new model
view helps you to find the right location in the model. The temporary model
view has the same coordinate system as the drawing view, and the same view
plane, visible objects, and view depths.

To create a model view, select the drawing view, right-click and select the
Create model view for selected view command. You can also find the
command on the contextual toolbar:

The new model view has the same name as the drawing view. As the view is
temporary, the name is in ( ) parentheses.

The temporary model view is removed when you close the view. If you want to
keep the view, rename it or just remove the parentheses from the view name.
You can easily rename the view in the Model views side pane.

Drawing view and model view visibility properties aligned

The model view that you create uses the same view properties and filters as
the drawing view. The visibility properties for object types and object groups
are automatically taken into account when the model view is created. When a
property is not set to visible in the drawing view properties, it is also not set to
visible in the model view properties.

Limitations

• Some modeling commands are not available when you have the general
arrangement drawing open. For example, you cannot perform numbering,
open other models, use the Save as command, or you cannot create any
type of other drawings. Tekla Model Sharing commands are not available.
To use these commands, you have to close the drawing.

• Grids cannot be selected between models and drawings.
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• The performance of model changes might be slightly affected while a
general arrangement drawing is open. The performance depends on how
many drawing views contain modified objects and the related objects in the
drawing view that need adjustments.

3.5 Intuitive 2D sketching, editing, and annotations in
drawings
Finalize designs efficiently with enhanced sketching, editing, and annotation
tools. In Tekla Structures 2026, 2D drawing sketching, editing, and annotating
are significantly enhanced through the renewed drawing mode ribbon, some
new commands, and other major improvements.

• The new Sketching tab is dedicated to sketching tools. The new, adaptive
Insulation command enables efficient sketching and automatically adjusts
to model changes. New sketching capabilities allow preselection of
drawing sketch objects and precise numeric input during dragging. Shape
positioning and status bar messages have been improved. Also the snap
grid can now be visualized and center line snapping works better.

• The Drawing tab has been updated and reorganized. It now contains
the new Copy continuously switch for selecting the copying mode and
the Paste command for copying from clipboard. The new Rectangular
cloud command and Cloud property pane enhance the flexibility in review
clouds.

• The improved Text and Text file features with the new, integrated Text
editor allow you to add formatted project notes easily, quickly, and
efficiently.

Renewed drawing ribbon

Dedicated tab for sketching tools

The drawing sketching tools have been moved to the new Sketching tab from
the Drawing tab. Now that the sketching tools are all located on the same tab,
they are quicker and easier to find and use.

The new Sketching tab:

• The new Sketching tab is available in all configurations that allow drawing
editing.
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• A new sketching command,  Insulation, has been added on the
Sketching tab. For more information, see "New sketch object - Insulation"
below.

• The command icons and labels are now clear, unified, and more intuitive.
Previously, most of the sketching commands did not have any command
names visible, only the tooltip indicated the command purpose.

Sketching commands on the ribbon in the previous Tekla Structures
versions:

TTSD-71228

Renewed Drawing tab
The commands within the Drawing tab have been reorganized. The renewed 
Drawing tab:

• The  Copy and  Move commands are now located next to each

other on the Drawing tab together with the new  Paste command,
just like in modeling mode. The new Copy menu has a new switch, Copy
continuously, for enabling or disabling continuous copying. The Copy
command now always copies the selected objects to the clipboard.

For more information about using the new Copy continuously switch and
copying to clipboard, see New clipboard for copying and pasting model and
drawing objects (page 13).

• All existing copying and moving commands are now located on the Copy

and Move menus, including the  Copy - Linear command, which could
earlier be used through Quick Launch only.

• A new cloud command,  Rectangular cloud, has been added for
quick creation of rectangular clouds. For more information, see "Create
rectangular clouds faster" below.
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• The old Cloud command has been renamed to  Polygonal cloud.

TTSD-71262, TTSD-73921

Preselect drawing sketch objects
In Tekla Structures 2026, you can now preselect drawing sketch objects. When
you move the mouse pointer over a sketch object, lines and handles are
highlighted. This new feature simplifies selecting the correct handle for actions
like resizing, making it easier to drag and reshape objects.

To enable the preselection of sketch objects, activate the Drawing drag &
drop option in File --> Settings in drawing mode.

Previously, while dragging in drawings, it was not clear which object would be
moved. Now, with the new preselection, you can use dragging with confidence.

TTSD-70792

Numeric input for dragging drawing sketch objects
When dragging handles, lines, or midpoints of drawing sketch objects, you
can now enter numeric values to specify the desired distance or location. This
works in a similar way as direct modification in modeling mode.

• To enter a numeric value, start dragging a handle, line, or midpoint. While
dragging, begin typing the desired value on the keyboard. The Enter a
Numeric Location dialog for typing the numeric value is displayed. Type
a distance or coordinates. When ready, click OK or press Enter on the
keyboard.

For handles, the numeric value tells how much you move the handle in the
direction of dragging, whereas for lines and midpoints, the numeric value tells
how much you move the line or midpoint perpendicularly.
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TTSD-73232

Visualized snap grid
• The snap grid in drawings is now visualized in the same way as in Template

Editor, for example. To activate the snap grid, go to File --> Settings -->
Snap settings, select Activate and click OK.

• The scale of the snap grid is now paper millimeters instead of view scale.

The first example below uses Spacing value 20 and the second example
Spacing value 10:

TTSD-69608

Improved snapping to center lines
Snapping to center lines in drawings now works better, and you can
easily snap to the actual center line end point, so that the snapped
point is associative. This works best if you have set the advanced option
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XS_DRAWING_ALLOW_SNAPPING_TO_DISTANT_POINTS to TRUE. Previously,
you would end up snapping to the center line extension.

TTSD-67770

New sketch object - Insulation
Tekla Structures 2026 introduces a new sketching command, Insulation,
to simplify the process of creating and editing soft and hard insulation in
drawings. Showing insulation in detail and section views is common especially
in general design drawings. This new feature allows for quick and efficient
sketching of insulation using a polyline-like input, ensuring details meet
expected standards.

Flexible modification: You can modify the representation properties of the
insulation before and after creation. Reshaping or resizing is easy with the
insulation handles.

Easy access: The new Insulation command is available on the drawing
Sketching ribbon tab, in the property pane object list, and through Quick
Launch.

Customizable insulation patterns: You can use any available soft and
hard insulation hatch patterns, including localized and customized patterns.
Hatches automatically scale to fit the width and rotate as needed.

Associative: Insulation objects are associative if they have associativity points,
meaning that they are associated with building objects.

The Insulation feature is part of a set of capabilities that enable the use
of one Tekla software from the early phases of an AEC project through to
completion. Previously, you had to design and use pattern lines or rely on
imported DWGs with pre-made details for insulation.

• In an open drawing, go to the new Sketching ribbon tab, hold down Shift

and click  Insulation. Adjust the properties in the property pane:
Select whether to show boundary lines or joining lines, set the line type and
color, select the fill type, color, and background, and define the insulation
width, scale, alignment, and position in relation to model objects. When
you are ready, pick the points that the insulation will traverse. To create the
insulation, click the middle mouse button or press Space or Enter on the
keyboard.
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• You can modify properties of the created insulation by double-clicking it in
an open drawing.

• You can move insulation objects by dragging. You can also reshape
or resize the insulation and move insulation segments by dragging the
insulation handles.

• You can also edit the width of the insulation by dragging a segment handle.
This changes the width of the insulation and the value of the Width
property in the property pane.

• You can also delete the selected insulation handles.

• Insulation is now available as an Object in the DWG/DXF/DGN drawing
export, and can be defined to be exported on a specific layer/level.
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Below an example of left-aligned insulation with the SOFT INSULATION type
and visible boundary and joining lines:

Below the same insulation is selected, showing handles and dimensions:
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Below the insulation is shown without boundary lines or joining lines:

Below the lines are visible:

Insulations indicate part shortenings:
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TTSD-71230, TTSD-72475, TTSD-73129

Create rectangular clouds faster
The new Rectangular cloud command allows you to create a rectangular
cloud more quickly by simply picking two points. Previously, you had to use
the Cloud command to create a polygonal cloud and then modify it into a
rectangular cloud.

• To create a rectangular cloud in an open drawing, go to the Drawing

ribbon tab and click the  Rectangular cloud command. Pick the first
corner point of the cloud and then the second corner point of the cloud.
You can resize the cloud by dragging the cloud handles.

• The Cloud command has been renamed to Polygonal cloud.
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• The two cloud commands,  Polygonal cloud and  Rectangular
cloud, both use the new Cloud property pane to get their properties,
streamlining their usage.

Previously, the Cloud command used the properties in the Polygon
property pane.

• Now you can define the cloud arc width for each cloud instance
separately in the Cloud property pane using the Width property.
Previously, this setting could only be set for the entire model using the
XS_ARC_WIDTH_OF_CLOUD advanced option. This advanced option has
been hidden from the Tekla Structures user interface.

TTSD-72769, TTSD-72464, TTSD-72994
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Other improvements in sketch objects
• Improved status bar messages: The short instructions on the status bar

have been improved to better explain the steps needed to use the drawing
editing tools and to give you more feedback.

TTSD-71262, TTSD-71273

• Exclusion of mouse position in final shape: The creation of sketch
objects based on multiple clicks has been improved so that the mouse
position is not included in the created shape when you click the middle
mouse button or press Enter to complete the creation of the sketch object,
such as a polyline.

Previously, an extra point was added at the location of the mouse pointer
when the middle mouse button was clicked.

TTSD-72006

New Tekla Structures built-in Text editor
Both the Text object and the Text file object (previously Rich text) now allow
using the new built-in Text editor for creating and editing of text content.

Open full Text editor

• Text file objects: In the Text file property pane, click the  plus button
and either link to an existing file or create a new file, and then open the
linked file by clicking Edit file.

New files are by default saved in the current model folder, but you can
change the location.

• Text objects: After adding the text in the drawing, in the Text property

pane, click the  Open full text editor button next to the Format list.

• Once you have added the text in the drawing, you can also open it in the
full Text editor by double-clicking the added text.
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How it works

• The toolbar contains all basic rich text formatting options, and you can also
add character symbols. All toolbar controls have informative tooltips. The
controls are the same for Text objects and Text file objects, except that
you cannot create tables in Text objects.

• You can change the zoom level by holding down the Ctrl key and scrolling
the mouse wheel, or using the zoom level control on the toolbar.

• For Text objects with rich text content, if the text content limit is exceeded,
a red border appears around the Text editor window, displaying the
message: "Text content limit exceeded. Please reduce the amount of text to
save changes."

• When you save the edited and formatted text in the full Text editor, the
Text editor closes, and the linked text file or the text in the Text property
pane is updated.

• You can open, edit, and save plain text files (.txt) in the full Text editor,
but you cannot apply any rich text formatting to those.

• The rich text files (.rft) no longer need to be created in Microsoft
WordPad as you can create them directly with Tekla Structures.

• You can set the new advanced option
XS_DRAWING_TEXT_FILE_OBJECT_USE_EXTERNAL_EDITOR to TRUE to always
use the associated external application for viewing and editing the .txt
and .rft files rather than the Tekla Structures built-in text editor. The
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default value is FALSE, which means that the Tekla Structures built-in text
editor is used. FALSE is the recommended setting to ensure you create
Tekla Structures compatible FALSE content.

Limitation

The .rft files created or modified in Tekla Structures 2026 or newer cannot
be used in older Tekla Structures versions as they will not be compatible and
no content will be displayed.

STP-593, TTSD-74966

Rich text support for Text objects
In addition to plain Text objects, you are now able to produce Text objects
with rich text content directly in your drawings, without having to use external
rich text files.

• To apply rich text formatting in Text objects, select the Text command from
the drawing property pane object list and select the Rich text option from
the Format list in the Text property pane. You can then apply the rich text
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formatting directly in the property pane text editor using the formatting
toolbar.

• The Plain text option allows you to enter plain text without formatting.

• The Text property pane toolbar contains the same controls as the full Text
editor.

• If the text content limit is exceeded, a red border appears around the editor
window with an exclamation mark. When you hover over the exclamation
mark, the tooltip "Text content limit exceeded. Please reduce the amount of
text to save changes." appears.

STP-593
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Text objects - Recover lost text changes
You can now recover lost text changes in drawing Text objects using the new

Recover changes  button.

This improvement was first introduced in Tekla Structures 2025 SP1.

TTSD-69225, TTSD-68443

If you are a Tekla Structures administrator
If you manage Tekla Structures settings for other users, update customized
settings for users.

Add the dedicated tab for sketching tools to the ribbon

If you have customized the ribbons, update your customized ribbon to the
dedicated tab for sketching tools.

1. Add the new tab Sketching tab:

• Add ribbon item: Tab

• Text: Sketching
2. Move these buttons from the Drawing tab to the Sketching tab:

• Line

• Polyline

• Rectangle

• Polygon

• Circle

• 3 point circle

• Arc

• 3 point arc

3. Add a vertical separator to the right of these buttons:

• Add ribbon item: Separator

• Appearance: Orientation: Vertical

4. To the right of the separator, add the new Insulation button to the
Sketching tab:

• Add ribbon item: Simple button

• Command: Shapes.DrawHatchline
• Appearance: Command: Scalable icon

• Text: Command: Short text
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5. Add a vertical separator to the right of the Insulation button:

• Add ribbon item: Separator

• Appearance: Orientation: Vertical

6. Move these buttons from the Drawing tab to the right of the separator on
the Sketching tab:

• Trim or extend

• Copy with offset

• Cut part lines

• Divide by n

• Split

• Straight chamfer

• Round chamfer

• Fillet

• Combine

• Explode

7. Add a vertical separator to the right of the Explode button:

• Add ribbon item: Separator

• Appearance: Orientation: Vertical

8. Move these buttons from the Drawing tab to the right of the separator on
the Sketching tab:

• Cover-up line

• Cover-up polyline

• Cover-up rectangle

• Cover-up polygon

9. Arrange and resize the buttons on the Sketching tab so that they have
this layout:

10. Save the changes.

The new ribbon configuration file is saved
to ..\Users\<username>\AppData\Local\Trimble\Tekla
Structures\2026.0\UI\Ribbons.

11. Move the file to the Ribbons sub-folder in a folder that is in the
XS_SYSTEM path.
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Add a hatch pattern for the Insulation sketch object

If you use a customized environment, add the new hatch pattern that
represents soft insulation to the hatch_types1.PAT file:

*SOFT INSULATION,

15.110989,26.505,25.092,-209.303509692,8.880015003,12.33,-516.923372264
15.110989,75.69,2.097,-209.303509692,8.880015003,9.9,-519.353372264
25.991447,38.403,28.305,-112.009672471,3.444901237,28.233,-1336.037718515
41.990007,85.248,4.68,30.767554237,34.182818635,9.9,-127.58947786
69.678693,92.601,11.304,43.127854876,15.971713037,9.9,-284.356344019
90,6.147,-2.412,0,102.190638456,4.824,-41.166297711
110.321307,9.585,34.299,-43.127854876,15.971713037,9.9,-284.356344019
138.009993,16.947,27.675,-30.767554237,34.182818635,9.9,-127.58947786
154.008553,63.783,5.31,112.009672471,3.444901237,28.233,-1336.037718515
164.889011,26.505,25.092,209.303509692,8.880015003,9.9,-519.353372264
164.889011,75.69,2.097,209.303509692,8.880015003,12.33,-516.923372264
195.110989,26.505,20.898,-209.303509692,8.880015003,9.9,-519.353372264
195.110989,75.69,43.893,-209.303509692,8.880015003,12.33,-516.923372264
221.990007,16.947,18.315,30.767554237,34.182818635,9.9,-127.58947786
249.678693,9.585,11.691,43.127854876,15.971713037,9.9,-284.356344019
270,96.039,25.407,0,102.190638456,4.824,-41.166297711
290.321307,92.601,34.686,-43.127854876,15.971713037,9.9,-284.356344019
318.009993,85.248,41.31,-30.767554237,34.182818635,9.9,-127.58947786
344.889011,26.505,20.898,209.303509692,8.880015003,12.33,-516.923372264
344.889011,75.69,43.893,209.303509692,8.880015003,9.9,-519.353372264

3.6 Improvements in reinforcement in drawings
You can now include rebar marks within rebar dimension marks by adjusting
the rebar dimension mark properties. The rebar-config.inp file has new
settings for bending radius, and you can drag associativity points of merged
rebar mark leader lines. Improvements have been made in pull-out pictures
to display bending radius symbols and labels, to include cross bars in the
pull-out pictures of rebar meshes, and to include longitudinal bars in bent
mesh dimensions.

Include rebar marks in rebar dimension marks
You can now include rebar marks directly within rebar dimension marks by
adjusting the rebar dimension mark properties, streamlining the production of
rebar drawings and ensuring compliance with industry standards.

In this new feature, rebar marks are associated with the rebar dimension
marks. Consequently, the rebar marks will automatically adjust their position
whenever the rebar dimension mark is moved.

Previously, rebar marks and rebar dimension marks had to be created and
modified separately, which was time consuming.

New settings for rebar marks have been added to the Rebar dimension
mark property pane, allowing you to include rebar marks when creating or
modifying a rebar dimension mark.
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• To include rebar marks in rebar dimension marks, select the Include rebar
mark checkbox and select the rebar mark property file that you want to
use for creating the marks.

• You can position rebar marks in relation to the rebar dimension mark by
selecting an option from the Position list. The options are:

Manual

Top-left

Middle-left

Bottom-left
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Top-center

Bottom-center

Top-right

Middle-right

Bottom-right

• You can manually drag the mark to any location, and it will retain its
association with the rebar dimension mark. When you do this, the Position
option changes automatically to Manual, indicating that the rebar mark is
no longer restricted to a fixed position.

Below is an example where the Top-left Position option has been selected.

Notes and limitations

• If the rebars in the drawing already have separately created rebar marks,
the Include rebar mark option does not work. You must first delete the
existing rebar marks before creating new rebar marks using the Include
rebar mark option in the Rebar dimension mark properties.

• If you move the rebar dimension mark outside the bar solid, the rebar
mark loses its adaptivity with the related rebar dimension mark. When you
move the rebar dimension mark back inside the bar solid, the rebar mark
will get back its adaptivity with the rebar dimension mark again.

TTSD-69109, TTSD-72569, TTSD-72568
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Drag merged rebar mark leader line associativity point
For merged rebar marks with a single leader line, you can now drag the mark
leader line associativity point to another location. Previously, dragging was
disabled.

This improvement was already introduced in Tekla Structures 2025 SP1.

TTSD-24079

New settings for bending radius in rebar_config.inp
There are two new parameters, PullOutBendingRadiusDimensionUnit and
PullOutBendingRadiusPrefix, in rebar_config.inp:

• PullOutBendingRadiusDimensionUnit:
PullOutBendingRadiusDimensionUnit defines the unit to be used in
the bending radius text in the pull-out. The options are:

0 = auto

1 = mm

2 = cm

3 = m

4 = inch

5 = foot and inch

6 = cm or m

If PullOutBendingRadiusDimensionUnit is not set, mm is
by default used for metric and inch for imperial. If
PullOutBendingRadiusAsMultiplier is set to 1, it takes precedence,
and PullOutBendingRadiusDimensionUnit has no impact.

• PullOutBendingRadiusPrefix: PullOutBendingRadiusPrefix defines
the prefix to be used in the bending radius text in the pull-out. If it is not
set, it will be defaulted to dBR=. If it is set to be empty, no prefix will be
output.

The format and precision of the radius dimensions are defined by the existing
settings in PullOutDimensionFormat and PullOutDimensionPrecision.

TTSD-71870
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Improvements in rebar pull-out pictures

Include cross bars in pull-out pictures

Rebar pull-out picture and marking: A new setting, Create cross bar marks,
has been added in Presentation options on the Rebar tab to include cross
bars in the pull-out pictures of rebar meshes. The options are Yes and No.

Draw rebar pull-outs: The new setting Create cross bar marks will also be
used in pull-out pictures created with the Draw rebar pull-outs tool if you
have selected to create the bending shapes on the basis of the saved Rebar
pull-out picture and marking configuration file and have set Create cross
bar marks to Yes in the selected configuration file.

In the example drawing below, the upper drawing view shows the rebar with
the new Create cross bar marks option set to No. The lower drawing view
shows the rebar with the new option set to Yes, and you can see the crossing
rebars as small circles.

TSAC-9238, TSAC-7315

Include longitudinal bars in bent mesh dimensions in pull-out pictures

A new advanced option, XS_REBAR_BENT_MESH_PULLOUT_DIMENSIONS_
INCLUDE_LONGITUDINAL_BARS, has been added to control whether
longitudinal bars are taken into account in the dimensions shown in a rebar
pull-out picture for a bent mesh. Set this advanced option to TRUE to take into
account the longitudinal bars, and FALSE to ignore them. TRUE is the default
value. This advanced option affects pull-out pictures in marks and templates.
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Below is an example of a bent mesh, which has longitudinal bars outside of
crossing bars. Now the longitudinal bars are taken into account in pull-out
picture dimensions.

In the example below, longitudinal bars are taken into account in dimensions.

In the example below, longitudinal bars are not taken into account in
dimensions.
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TTSD-74429

Showing bending radius symbol and label in pull-out pictures

Rebar pull-out pictures now use the standard tie/stirrup bending radii from
the rebar catalog to determine if the bending radius symbol and label should
be shown: When the bending radius equals the tie/stirrup radius value, the
symbol and label are not shown. For all other radius values, the symbol and
label are shown. Previously, hard-coded values were used instead of the values
from the rebar catalog.

TTSD-72954

3.7 Enhancements in drawing colors and lines
In Tekla Structures 2026, enhancements in object colors and line types
were further continued to better meet the related industry standards and
regulatory requirements. You can now define the color and line type for
section lines and own hidden lines in pour objects in the object, view, and
drawing level properties. Additionally, you can set a fill color for filled rebar
and mesh lines.

New controls for setting color and type of section lines and
own hidden lines in pour objects
You can now control the color and type of section lines and own hidden
lines for pour objects in all drawing types through the object and view level
properties. In general arrangement drawings, you can also control these
properties through the drawing level properties. The new settings, Section
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lines and Own hidden lines, support both standard colors and custom RGB
colors.

The new line controls in the Pour object properties in the property pane:

The new line controls in the pour object properties on the view and drawing
level:

Previously, only the color and type of visible lines and hidden lines in pour
objects could be adjusted.

The new pour object line controls were already introduced in the Pour object
property pane in Tekla Structures 2025 SP2.

TTSD-69337, TTSD-69338
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New control for setting fill color for filled rebar and mesh
lines
Fill color has been added as a setting for filled rebar and mesh lines in the
following dialogs and property panes:

• On the Bar appearance and Mesh appearance tabs in the reinforcement
and neighbor reinforcement properties in GA drawings on the drawing and
view level

• On the Bar appearance and Mesh appearance tabs in the reinforcement
and neighbor reinforcement properties in cast unit drawings on the view
level

• In the Rebar and Rebar mesh property panes

The Fill color setting is available if you have selected filled line as the
representation type for the rebar or rebar mesh. You can use a standard color
or a custom RGB color.
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TTSD-70581, TTSD-65784
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3.8 Other improvements in drawings
Tekla Structures 2026 also contains improvements in Document manager
messages, automatic view dimensioning, defining drawing sizes and drawing
frame margins and colors, Drawing content manager categories, CIP
continuous material visibility, associativity symbols, reference model visibility,
detailed object level settings, and log locations.

Document manager
Some messages displayed in the Changes column in Document manager
were updated to be more concise and in line with other Document manager
messages:

Drawing cloned (earlier: Drawing was cloned)

Drawing cloned from cloud [earlier: Drawing was cloned from cloud)

Drawing updated (earlier: Drawing was updated)

TTSD-67170

Enhancements in dimensioning

New dimensioning type in automatic view dimensioning - Center of
gravity dimensions

Tekla Structures 2026 provides a new rule-based dimensioning type, Center
of gravity dimensions, in the view-specific dimensioning. Now you can create
dimensions indicating the center of gravity automatically in your fabrication
drawings.

What's new in drawings in Tekla Structures 2026 91 Other improvements in drawings



This improvement was already introduced in Tekla Structures 2025 SP2.

TSAC-8713
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Bolt size dimensioned in view-specific dimensioning

When you dimension bolt groups using the Filter dimensioning type, the bolt
groups are now dimensioned not only by bolt positions but also by bolt size.

TSAC-8890
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Drawing Layout editor - New dialogs for defining drawing
sizes and frame margins
The Drawing size settings dialog now allows you to:

• Add or edit drawing sizes using a dedicated dialog. Right-click a drawing
size row and select Edit to open the dialog, then enter the values. If
necessary, select Autosize.

• Define frame margins and colors using a dedicated dialog. Right-click a
frame row and select Edit to open the dialog, then enter the values and
select the color.

This improvement was already introduced in Tekla Structures 2025 SP4.

TTSD-71227, TTSD-50381

Surface treatments in Drawing content manager
Drawing content manager has a new building object category: surface
treatments. You can now easily define and manage marks for painting and
coating surfaces, and check if the surface treatments have all the marks, and
easily add or remove marks.

TTSD-73166
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CIP Continuous material to use correct solid in drawings
If a continuous material part has an edge chamfer, the edge chamfer will
always be visible in the drawings as well. Similarly, the inner loops (holes) are
always visible in the drawings, regardless of the part settings Outline or Exact.
The solid clipping operation is defined only for those solid forms that include
these settings.

TTSD-74077

Consistent associativity symbol size
The associativity symbol is now drawn in screen coordinates. Previously, the
symbol size changed when you zoomed, now it stays the same.

TTSD-72111

Reference models visible in drawings
All reference models are now visible in the Reference objects list in the
Reference object section of the drawing view properties. Previously, some
reference models were sometimes disappearing from the list and could not be
shown in drawings.

This improvement was already introduced in Tekla Structures 2025 SP5.

TTSD-69406
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Detailed object level settings
View-level detailed object level settings did not work correctly if the drawing-
level detailed object level settings were turned off. This issue has now been
fixed.

For more information, see Create and apply detailed object level settings.

This improvement was already introduced in Tekla Structures 2025 SP6.

TTSD-73541

Location change for drawing, cloning, and printing logs
• The printing log file, DPMPrinter_<print_job>.log, is now saved in

the application data log folder in %LocalAppdata%\Trimble\Tekla
Structures\<version>\Logs. Earlier, this log was saved in the current
model folder.

TTSD-69883

• The drawing_cloning.log and drawing_history_log are now saved
in the \logs folder under the current model folder. Earlier, these logs were
saved in the model root folder.

TTSD-70361
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4 What's new in connected
workflows in Tekla Structures
2026

• Integrated Trimble Connect property sets

• Upload PDF drawings directly to Trimble Connect

• Import from Tekla Structural Designer using remote connection

• Publish Tekla Structures models to Tekla Structural Designer (Preview)

• Integration with Autodesk Revit (Preview)

• Improvements in Tekla PowerFab Connector

• Improvements in Live Collaboration for Tekla Structures (Preview)

4.1 Integrated Trimble Connect property sets
In Tekla Structures 2026, you can utilize accurate, up-to-date property data
from the construction site or factory through the integrated Trimble Connect
property sets.

Synchronize and manage property sets from Trimble Connect in Tekla
Structures. Use the property set data in filters, reports, templates, marks in
drawings, such as in part marks, Organizer, and IFC exports similar to regular
template attributes, to enhance the project data utilization and to track project
progress. Any changes made to the property sets in Tekla Structures are
automatically synchronized with Trimble Connect and all other property set
service clients. Property set properties can be associated with model objects
either in Tekla Structures or Trimble Connect. Note that the property set
date field is not working as expected at the moment. This affects IFC export,
drawings, filtering, and the project status visualization tool. The date field
works correctly with reports, IFC4, and Organizer.

Prerequisites for using property sets in Tekla Structures
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• Your Tekla Structures model needs to be linked to a Trimble Connect
project.

• You need to have the property sets defined in property set libraries in
Trimble Connect.

Open the Property sets side pane

In Tekla Structures, on the Trimble Connect ribbon tab, click the 
Property sets button to open the Property sets side pane window.

Use the side pane window to add or edit the property sets. Any changes made
in Tekla Structures are automatically synchronized with Trimble Connect. Tekla
Structures and Trimble Connect use the same property set service, enabling
synchronized property set data in all applications that are using the property
sets.

In Tekla Structures, the synchronization happens automatically when you open
Tekla Structures or a Tekla Structures model, or when something has been
changed in Trimble Connect. If a property set value is modified in Trimble
Connect or in other property set service clients, the value is automatically
cached in Tekla Structures. This enables the usage of accurate property set
data in Tekla Structures. To synchronize the property set data manually, click

the  button.

Cache file for property set data

The property set data is stored in a local cache file, PropertySetCache.LUMO,
which is created during the initial synchronization process and is located in the
Tekla Structures model folder.

Once the local cache is created, it is automatically updated with the latest
changes during subsequent synchronizations. If the cache file is deleted or

does not exist, clicking the  button recreates it.

Use property set data in Tekla Structures

In Tekla Structures, you can use the property set data in several ways, similar
to how you would use regular template attributes or user-defined attributes
(UDAs).

For example, use the property set data in following ways:

• In filtering: create selection filters or view filters based on property data.

• In reporting: generate reports using property data, such as fabrication or
shipping status.

• In drawings: add property data, for example, to part marks, associative
notes, and drawing templates.

• In IFC export: include the property set properties when exporting models
for external stakeholders.

Syntax for property set data in Tekla Structures
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Use the property set data in filters, reports, templates, marks in drawings
(such as part marks), Organizer, and IFC exports. Ensure that the property sets
use the following syntax:

• For parts: PSET.<LibraryName>.<PropertySetName>.<Property>
Note that the <LibraryName> is optional, but <PropertySetName> and
<Property> are mandatory.

• For assemblies:
ASSEMBLY.PSET.<LibraryName>.<PropertySetName>.<Property>

• For cast units:
CAST_UNIT.PSET.<LibraryName>.<PropertySetName>.<Property>
Adding ASSEMBLY or CAST_UNIT prefix allows you to use the property sets
on the assembly or cast unit level.

Follow the regular template attribute syntax and use the property set data
in cases where you would typically use UDAs or template attributes.
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TTCEX-415

If you are a Tekla Structures administrator
If you manage Tekla Structures settings for other users, update customized
settings for users.

Update the ribbon for integrated Trimble Connect property sets

If you have customized the ribbon, update your customized ribbon to add the
new Property sets button.

1. On the tab, add the new Property sets button between the existing BCF
Topics and Status Sharing buttons.

• Add ribbon item: Simple button

• Command: TrimbleConnect.PropertySets
• Appearance: Command: Scalable icon

• Text: Command: Short text

2. Save the changes.

The new ribbon configuration file is saved
to C:\Users\<username>\AppData\Local\Trimble\Tekla
Structures\2026.0\UI\Ribbons.

3. Move the file to the Ribbons sub-folder in a folder that is in the
XS_SYSTEM path.

4.2 Upload PDF drawings directly to Trimble Connect
In Tekla Structures 2026, you can now upload PDF drawings directly from Tekla
Structures to Trimble Connect with accurate metadata, preventing outdated
drawings from being used. When you print drawings, you can automatically
upload them with the option to link PDFs directly to the corresponding
parts and assemblies in the Trimble Connect model, and store drawings
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alongside the model objects. The shop and field crews can easily access the
latest drawings on a tablet, right next to the actual object they are working
on, ensuring that they always have the most up-to-date information. This
prevents version control issues where shop or site teams might accidentally
use outdated printed drawings. Additionally, API integrators can use the
drawing metadata, such as title and revision, to reduce manual data entries
and streamline processes. Note that while this metadata is accessible, some
effort will be required to integrate it effectively into specific workflows.

As a prerequisite, your Tekla Structures model needs to be linked to a Trimble
Connect project. See instructions here: Link a Tekla Structures model to a
Trimble Connect project.

1. Start by setting up the drawing upload folders that will be used in Trimble
Connect. You can set the folders separately for each drawing type.

a. Go to File --> Trimble Connect --> Upload drawing settings.

The Upload drawing settings dialog opens.
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b. Click … to open the Folder browser dialog. Browse for the folder you

want to use for the drawing upload, or click  to create a new
folder.

Alternatively, you can enter the folder path, and a folder is created
automatically.

You can upload assembly drawings, single-part drawings, cast unit
drawings and general arrangement drawings.

c. Repeat this for all drawing types, if needed. Click OK.

d. If needed, you can save the set folder locations to an attribute file.
The file extension is TCDrawingSettings.xml, and the file is stored
in the model folder\attributes folder.

e. When you have set the folders, click OK to close the Upload drawing
settings dialog.

2. To upload the PDF drawings to Trimble Connect, go to Drawings &
reports --> Document manager.

a. In the Document manager dialog, select the drawings you want to
upload to Trimble Connect.

b. Right-click and select Print, or click the Print  button. The Print
drawings dialog opens.

c. In the Trimble Connect section, select the Link drawings to model
objects checkbox if you want to link the fabrication drawings to
related model objects in Trimble Connect, if the model has been
uploaded.

For assembly drawings and cast unit drawings, you can select
whether the drawing is linked to the assembly or the main part.

General arrangement drawings cannot be linked to model objects.
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d. If you have not yet selected the PDF drawing upload folder for each
drawing type in Trimble Connect, you can do it by clicking … next to
Upload drawing settings. By default, the current settings are used.

e. Click Print and upload to Trimble Connect to upload the PDF
drawing to the set folder in Trimble Connect.

The upload will take a while. Note that a large model can contain too
many objects for the linking, causing performance issues in Trimble
Connect.
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When the uploading is done, Tekla Structures displays a notification
stating if the upload was successful or whether there were warnings
or errors.

For example, you may get the following notifications.

3. If you are an API integrator, you can use drawing metadata to integrate
the information in your processes. Drawing metadata is stored as Trimble
Connect property sets.

If you are uploading the drawings for the first time and have sufficient
rights, or you are a Trimble Connect project administrator, a new property
set library and definition will be created to store the drawing metadata
from Tekla Structures. The metadata is not visible in files in Trimble
Connect, only in model objects, but it can be fetched via Trimble Connect
API.

For a reliable workflow, use the API call /psets/{link}/{libId}/
{defId}. You need to identify the drawing's document ID, as well as the
ID of the metadata property set library and the definition. If these are
unknown, they can be identified via the Trimble Connect API:

• For library: /forests/{forestId}/trees/{treeId}/nodes/
{nodeId}/links

• For definition: /libs/{libId}/defs
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Metadata library IDs follow a naming convention:

• <projectId>_MetadataLibrary_<8 character length GUID>
• <projectId>_MetadataDefinition_<8 character length

GUID>
Metadata contains the following information. All fields are of type Single
value.

Name Type
Mark Text
Drawing name Text
Creation date Date
Modification date Date
Drawing type Text
Authoring software Text
Title 1 Text
Title 2 Text
Title 3 Text
Revision author Text
Revision mark Text
Revision description Text
Revision creation date Date

TTSD-71062

4.3 Import from Tekla Structural Designer using remote
connection
In Tekla Structures 2026, you can now connect with and import models from
Tekla Structural Designer that is installed on another computer.

To import Tekla Structural Designer models, go to the File menu in Tekla
Structures and click Import --> Tekla Structural Designer.

In the Tekla Structural Designer Import dialog, you can now select the Use
remote connection checkbox under Remote connection to use a VPN or
private local network, and then click the Select connection file button to use
the connection information received from Tekla Structural Designer.

TTSD-70994
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4.4 Publish Tekla Structures models to Tekla Structural
Designer (Preview)
You can now publish full Tekla Structures models or selected parts of a model
to the cloud, enabling a Tekla Structural Designer user to bring them in
without both applications needing to be on the same computer.

Tekla Structures 2026 introduces the Publish to Tekla Structural Designer
functionality as a Preview feature. To find out more, see Preview features in
Tekla Structures.

This new workflow supports revision handling. Steel and concrete models with
columns, beams, braces, walls, and slabs can be transferred to Tekla Structural
Designer. Profiles and material grades are mapped automatically, and design
characteristics are set in Tekla Structural Designer for immediate use.

To publish model objects from Tekla Structures to Tekla Structural Designer,
go to the File menu, click Export --> Publish to Tekla Structural Designer,
and use the Publish to Tekla Structural Designer dialog to define the cloud
publishing settings, or the local export settings if needed.

TTSD-74017, STP-539

4.5 Integration with Autodesk Revit (Preview)
You can now transfer models between Tekla Structures and Autodesk Revit
using .cxl files.

To do this in Tekla Structures 2026, use the new commands on the File menu:

• Import --> Autodesk Revit with CXL

• Export --> Autodesk Revit with CXL

Tekla Structures 2026 introduces the CXL integration with Autodesk Revit
functionality as a Preview feature. To find out more, see Preview features in
Tekla Structures.

TTSD-73168

4.6 Improvements in Tekla PowerFab Connector
Multiple improvements and fixes in Tekla PowerFab Connector have been
released in the 2025 service packs.

See the following release notes:

• Tekla Structures 2025 SP1:

• Enhanced usability and visual feedback

What's new in connected workflows in Tekla
Structures 2026

106 Integration with Autodesk Revit (Preview)

https://support.tekla.com/doc/tekla-structures/not-version-specific/preview_features_by_license
https://support.tekla.com/doc/tekla-structures/not-version-specific/preview_features_by_license
https://support.tekla.com/doc/tekla-structures/not-version-specific/preview_features_by_license
https://support.tekla.com/doc/tekla-structures/not-version-specific/preview_features_by_license
https://support.tekla.com/doc/tekla-structures/2025/rel_2025_sp1_new_features_and_improvements


• The workflow for managing procurement data has been optimized

• Tekla Structures 2025 SP3:

• Exporting UDAs from reports to Tekla PowerFab is now possible.

• Issue with submittal to Tekla PowerFab fixed

• Tekla Structures 2025 SP5:

• The Submittal history now automatically converts the "Checked date" to
the current user's local time.

• Improved validation accuracy

• Improved workflow stability in assembly drawing exports

4.7 Improvements in Live Collaboration for Tekla
Structures (Preview)
Live Collaboration was introduced as a preview feature in Tekla Structures
2025, and in Tekla Structures 2026 it continues to have the preview status.

In Tekla Structures 2026, Live Collaboration has undergone other
improvements.

• Share a selected view in a Live Collaboration session

When you start a Live Collaboration session, you can now select the view
you want to share, and share only that view to the session. The current
view settings and object representation filters are shared with the view. Any
changes made in other views are not shared.

If you want to share a full model to the Live Collaboration session, you
need to have the full model visible in the view that you are sharing.

• Consider the following when you are deciding whether to share a model
or a view in the session:

  Advantages Disadvantages
If you share the whole
model

Enables quick sharing,
depending on the model
size, and provides a
comprehensive overview
of the entire model.

Not recommended if
you work with Autodesk
Revit because of
performance impacts on
Autodesk Revit.

If you share a view Enables faster sharing
for Tekla Structures,
Trimble Connect, and
Autodesk Revit teams by
focusing on small parts
of the project.

Only what is in the
shared view is visible.

You can add more
views to the Live
Collaboration session
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  Advantages Disadvantages
to add more model
context.

• If you use Tekla Model Sharing, consider the following when you are
deciding whether to share a model or a view in the session:

  Advantages Disadvantages
If you share the whole
model

Enables quick sharing,
depending on the model
size, and provides a
comprehensive overview
of the entire model.

Native Tekla Structures
parts and models from
Live Collaboration can
potentially overlap.

If you share a view Enables faster sharing
for Tekla Structures,
Trimble Connect, and
Autodesk Revit teams by
focusing on small parts
of the project.

Native Tekla Structures
parts and models from
Live Collaboration can
potentially overlap.

If you share the model
changes only

Optimized for Tekla
Model Sharing
workflows within the
same team and the
same model.

Not suited for Trimble
Connect and Autodesk
Revit teams because
only the changes are
shared and the model
context is missing.

TTSD-72619

• Remove the model from the Live Collaboration session

You can now remove models published to a Live Collaboration session
by clicking the three dots next to the model name and selecting Remove.
Additionally, if you close the Tekla Structures view that is currently shared
in the session, the view is removed from the session.

TTSD-73118

• Clip boxes can be shared in the Live Collaboration session

Sharing clip boxes in Live Collaboration sessions now works.

Note the following:

• If you share clip boxes from Tekla Structures to Trimble Connect, the clip
boxes work correctly.
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• If you share clip boxes from Trimble Connect to Tekla Structures or
between two Tekla Structures, and you have previously added a clip box
in Tekla Structures, the clip boxes work correctly.

If you have not previously added a clip box, the clip box planes are
visible but they cannot be modified.

The clip box feature is activated only when using clip boxes from the
ribbon.

TTSD-67408
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5 What's new in interoperability
tools in Tekla Structures 2026

• Enhanced IFC interoperability

• Layout manager - Enhanced workflow efficiency with point deviation
management

• Updates in tools for automated precast fabrication

• Improvements in reference models

5.1 Enhanced IFC interoperability
In Tekla Structures 2026, managing IFC exports for all versions (IFC2x3, IFC4,
and IFC4.3) is now streamlined through a single, enhanced Export IFC dialog.
This unified dialog offers direct upload to Trimble Connect, precise object
selection, and customizable IFC entity attributes. The IFC4.3 export now
includes support for the Building domain. Furthermore, the control of IFC
entities within model object properties has been improved. Additionally, the
conversion of IFC objects now supports converting IFC4 reference objects into
native objects.

One dialog for all IFC export versions
The IFC2x3 and IFC4 export dialogs have been merged to provide aligned
controls and a consistent workflow. You no longer need to open two different
dialogs to export different IFC versions: When you select File --> Export -->
IFC, the new Export IFC dialog opens, allowing you to export all IFC versions
supported in Tekla Structures.

The new Versions list lets you choose the IFC export version: IFC2x3, IFC4, or
IFC4.3. Select the version first, as the dialog updates to show settings relevant
to your choice. Note that not all settings apply to every IFC version.
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Additionally, you can now use Open API the same way for IFC2x3 and IFC4.

TTSD-69046, TTSD-73253

Accurate selection of exported objects
You can now precisely restrict exports to specific model objects, ensuring
accurate communication of design information. It is possible to flexibly export
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selected objects within an assembly and choose whether to include assembly
information without exporting the entire assembly. Additionally, exporting can
be further automated with the new filtering option.

In the Object types section, select desired object types and use the following
Selection options:

• All objects: Export all model objects. The export of bolts, welds, grids,
reinforcements, surface treatment and surfaces, and spaces depends on
whether their respective checkboxes have been selected in the export
settings.

• Selected objects: Export only the selected objects. For example, selecting
only a plate in an assembly exports just the plate. Also, if you have a cast
unit column with rebars and embed parts, and only want to export the
embed parts, select only the parts (column and embed parts) in the model
and then select both the Selected objects option and the Reinforcing
bars checkbox, because embed parts are modeled as reinforcement.

• Selected objects and their assemblies: Export selected parts and their
assemblies. For example, selecting only a plate in an assembly exports the
entire assembly associated with the selected plate.

• Selection filter: Use a predefined filter to further restrict the export to
certain types of objects.

• Include assembly information: Export information about the assembly
hierarchy of objects. Even if only a part of the assembly is exported, the
entire assembly hierarchy and its information are included. For instance, if
an assembly contains three parts and you choose to export only two, this
option ensures that the export file recognizes these two parts as belonging
to the same assembly. Use this option in conjunction with a Selection
option, such as Selected objects.

TTSD-71033, TTSD-71311

Override IFC entity attributes
You can now modify IFC entity attributes that were previously fixed (hard-
coded). The new Attribute overrides control in the Export IFC dialog allows
you to customize specific IFC entity attributes, such as Name, Description,
or Tag, by specifying export values tailored to meet project specifications,
standards, or customer requirements. You can designate a Tekla property, a
user-defined attribute, or a custom property as the export value.

Previously, all IFC entity attributes defined by the IFC schema were hard-coded,
limiting control over the output. The essential attributes, such as GlobalId, are
still hard-coded. The default value is set to <none>, indicating that the export
will use the predefined values.

Examples of IFC entity attributes and their export values:
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• To start defining a new attribute override, select <new> from the Attribute

overrides list and click  Edit.

This opens the new IFC attributes dialog.

• To add an attribute override, click the  plus button on the right. In the
displayed Add attribute override dialog, define the desired IFC version,
and select one or more IFC entities from the list of entities. You can also
apply a filter to further limit which objects are affected. The Attributes
to override list is populated with attributes that can be overridden based
on your IFC entity selection. If you select more than one IFC entity, the
attribute list will display only those attributes that are common to all
selected entities. Click Add when ready.
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The attributes that you added for the selected entities are displayed on the
Attribute definitions list at the bottom of the IFC attributes dialog.
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• Now you can customize the attribute definitions. Select an attribute from

the Attribute definitions list and click  Edit. Select a Tekla property
from the list, or enter a user-defined attribute or custom property. To
narrow down the list of available attributes, select an attribute group from
the Group list. Click Modify when ready.
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• When you have defined the needed override rules, give the rule set a name
and click  Save. This will save a new <name>.attributeoverride file in
the \IfcAttributeOverrides folder under the current model folder.

TTSD-71028
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Direct export to Trimble Connect
In the new Export IFC dialog, you can now publish IFC files directly to a
Trimble Connect project and folder, matching the workflow used for the native
TrimBIM format and removing the need for manual file handling.

• Specify the Trimble Connect Project to enable direct upload. If the model
is already connected to a Trimble Connect project, the Linked Trimble
Connect project option is automatically selected. If the model is not
connected to a Trimble Connect project, None is displayed, and you can
manually select the desired project.

• Select a Trimble Connect folder in the selected project.

• You can change the project and folder at any time.

• Your selections are saved in the export settings.

• When ready, select Export and upload to Trimble Connect.

TTSD-69043

Enhanced control over IFC entity selection
Now you can more accurately specify the needed IFC entity for each object
in the Tekla Structures model so that the created IFC file has the required
information.

• More IFC entity types are supported:

IfcCovering

IfcCurtainWall

IfcRampFlight

IfcStairFlight

• You can now change the IFC entity for rebars.

• You can now set the assembly entity to None.

• You can start typing the name of the IFC entity and the matching entities
are shown in the list.

• Strands can now be exported as IfcTendon also in the IFC2x3 export.
Previously, this worked only in the IFC4 export.

TTSD-71058, TTSD-71057, TTSD-66167, TTSD-65637, TTSD-62542, TTSD-48482,
TTSD-61973, TTSD-72410
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More extensive support for IFC 4.3 schema
• Tekla Structures 2026 supports the IFC 4.3 schema in accordance with the

latest buildingSMART release IFC 4.3.2. You can now export models using
the IFC 4.3 schema and meet the mandatory requirements for structural
deliverables.

• In the IFC4.3 export, the Building domain is now supported in addition to
the already supported Bridge domain.

• The IFC4.3 export now supports the Reference view and Design transfer
view export types in addition to the already supported Bridge view export
type.

STP-589, TTSD-73781

IFC header change
IFC header information has been changed to comply with the buildingSMART
recommendation.

For Tekla Structures, the following information is now written in the IFC file
header, in the FILE_NAME record:

Trimble Inc. - Tekla Structures - <version number>
TTSD-70252

Improved grid export
In the IFC4 and IFC4.3 exports, when exporting selected objects, grids are
now exported only when they are selected. Previously, all grids in the model
were exported even if you had selected to export selected objects only. When
you select Spatial hierarchy from Organizer, grids are positioned under the
corresponding building (whose boundary covers the grids), otherwise under
the first building.

TTSD-73001
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IFC object conversion - Support for IFC4 formats
The IFC4.0 format and any newer IFC4 formats are now supported when
converting IFC reference objects into Tekla Structures native objects.

Previously, the object conversion only supported IFC2x3 reference objects.

TTSD-57949

5.2 Layout manager - Enhanced workflow efficiency with
point deviation management
In Tekla Structures 2026, you can now use the new out-of-tolerance check in
Layout manager to identify discrepancies between what has been designed
and what has been built. This brings considerable efficiency to the workflow
between the design office and the construction site.

In Layout manager, you can now define tolerance values for the points
measured on the site, and easily compare the locations of the measured
points with the corresponding points designed in the Tekla Structures model.
With the point deviation data, project quality and accuracy is improved as
project teams can make quick, informed decisions based on reliable data from
the site and the model, and prevent costly future rework.

Define the tolerance values for measured points

Tolerance values define how much the points measured on the site can
deviate from the points designed in the model.

You can define the Horizontal tolerance and Vertical tolerance values in the

Layout manager Settings , under the Measured Points section. You
can either select a horizontal and vertical tolerance value from the list, enter a
desired value in the box below the list, or select that the tolerance values are
ignored.

You can also define a separate class for the points that are out of tolerance to
easily visualize them in the model.
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Compare measured points with design points

Layout manager now automatically compares the points measured on the
site with their corresponding design points in the model when layout data
from the site is imported to Layout manager. The data is imported in .tfl
and .tflx files. Layout manager calculates the deviations between the
points based on the tolerance values that you have defined for measured
points.

The measured points that are outside the defined tolerance values are listed in
the new Out of tolerance group in Layout manager. The Out of tolerance
group is empty if there are no points that are out of tolerance.

Measured points now automatically have the suffix _MP added to their original
names. This makes it easier to identify and distinguish them from design
points both in the model and in drawings. The group name is shown in
parentheses at the end of the name.

When you select a measured point in the Out of tolerance group, the point
properties on the right show the X, Y, V, and H deviation parameters, and the
date when the point was created. The out-of-tolerance values are highlighted
against a red background so that you can easily see which values are outside
the defined tolerance values.
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Visualize measured points in the model

You can use the new Layout tolerance options in Layout manager
to select which layout objects are shown in the model:

• Show only measured points temporarily hides all layout objects except
measured points.

• Show only out-of-tolerance points temporarily hides all layout objects
except the measured points that are out of tolerance.

• Show all restores the visibility of all layout objects.

Create reports for layout points

You can now create reports for the layout points that you select in Layout
manager. When you have selected the layout points or groups that contain
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layout points in Layout manager, click the  Report button. Then enter a
name for the report file. By default, the report file is saved as a .csv file in the
\Layout\Reports folder under the current model folder.

Layout point reports are useful for reporting accurate deviation information.
You can open and import the reports in Microsoft Excel, for example.

TSAC-9420

Improvements in Tekla Structures 2025 SP5
The following improvements were already introduced in Layout manager in
Tekla Structures 2025 SP5:

• You can now select multiple layout objects and groups in the Layout
manager tree structure by holding down the Ctrl or Shift key.

TSAC-9154

• You can now drag selected layout objects to a new location within a group
or to another group in Layout manager. You can also change the order of
groups by dragging them in the Layout manager tree structure.

TSAC-9009

• The Auto highlight and Stay on top settings are now saved and restored
from the saved settings when opening Layout manager.

TSAC-9365

5.3 Updates in tools for automated precast fabrication
Tekla Structures 2026 comes with a number of enhancements in the tools for
automated precast fabrication.

Unitechnik export
• A new user-defined attribute for layer identification code,

UT_ConLayerCode, has been added for concrete parts. You can now specify
the layer identification code using the new Layer identification code
property on the Unitechnik tab in the user-defined attributes of a concrete
part. Enter a numeric value.

This improvement was already introduced in Tekla Structures 2025 SP1.

TSAC-9183
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• A new user-defined attribute, UT_ConLayerInfo, has been added for
concrete parts. You can now specify additional information for layer
identification using the Additional layer information property on the
Unitechnik tab in the user-defined attributes of a concrete part.

This improvement was already introduced in Tekla Structures 2025 SP6.

TSAC-9621

• On the SLABDATE block data specification tab, you can now specify the
type of the Slab area for the export. The options are Gross area, Net area
with cutouts, Net area without cutouts, and Template.

This improvement was already introduced in Tekla Structures 2025 SP3.

TSAC-9273

• On the Embeds tab, you can now specify the surface treatment to export
by giving the surface treatment name in Surfaces. You can also select the
surface installation type using any of the following options:

Installed (0)

Only plotted (1)

Only installed (2)

Not installed, not plotted (3)

Installed in reinforcement (4)

Installed automatically (5)

TSAC-8450

• On the Symbols tab, you can now specify the embeds that should be
exported with center line or reference line using the new options Embed
represented by center line and Embed represented by reference line.
Enter the class or name of the embed.

TSAC-9286

ELiPLAN export
• When plotting the reinforcement, you can now omit reinforcement outside

concrete elements using the new setting, Omit reinforcement outside
concrete, on the Plotter data tab.

TSAC-8811

• You can now define how the matching of tags in the data conversion
works using the new setting Matching conversion on the Parameters
tab. The Any tag option works in the same way as the conversion worked
previously: if any tags are found, conversion is done. With the All tags in

What's new in interoperability tools in Tekla
Structures 2026

123 Updates in tools for automated precast
fabrication

https://support.tekla.com/doc/tekla-structures/2025/rel_2025_sp6_new_features_and_improvements
https://support.tekla.com/doc/tekla-structures/2025/rel_2025_sp3_new_features_and_improvements


order option all tags must be present in the given order for the conversion
to be done.

TSAC-8765

BVBS export
• You can now export the image file name in the ID-SUBID format in the

private data block by selecting the new option, Export image ID, on the
Data content tab.

TSAC-9626

This improvement was already introduced in Tekla Structures 2025 SP6.

• A new template attribute, IMAGE_ID, has been added that matches
the format of rebar image file names output by reports: <Id>-<SubId>.
Currently, this attribute should only be used with report templates. If it was
used via OpenAPI, the SubId part will always be 0.

TTSD-71601

• You can now combine two identical rebar groups into one line in the export
file according to the rebar geometry by selecting the new Single rebars
and rebar groups option By geometry on the Advanced tab.

TSAC-8874

5.4 Improvements in reference models

Refreshing reference models
When refreshing reference models, and if some of the original reference
models are not found, you get a list of missing reference models. Now the list
is displayed only and you do not need to click OK to continue working. Earlier,
you had to click OK to continue your work. This improvement was made so
that automated processes are able to continue without stopping in the middle
of the process.

This improvement was already introduced in Tekla Structures 2025 SP1.

TTSD-69020
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6 What's new in components in
Tekla Structures 2026

There are many improvements in concrete components and steel components
in Tekla Structures 2026. In the Tekla Structures Graphite configuration,
detailing components can now be created in the same way as in the Tekla
Structures Diamond configuration.

6.1 Concrete components

Component What's new
Braced girder (88), (89) On the UDA tab, there are now six

new variable UDAs where you can
define the type, value, name, and the
object a UDA belongs to.

TSAC-9292, TSAC-9293
Concrete console (110) • On the Picture tab, there is a

new option for the beam-column
connection type for situations
where the secondary beam is
sloped. This new option has a
horizontally placed corbel and
plates combined with an aligned
column top level and beam.

TSAC-9040

• On the Parts tab, there is a new
setting, Align with, where you can
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select whether to align the holes
or bolts in the neoprene plate
and horizontal plate parallel to the
anchors or perpendicular to the
plates.

TSAC-7882

• On the Anchor rods tab, you can
now select to create a specific
Profile when creating holes in the
beam. You can select a profile for
both the top and bottom part.
Previously, only circular or square
holes could be created.

TSAC-7564

• On the Picture tab, there is a new
setting where you can define the
offset of the horizontal steel plate
over the console.

TSAC-7562

• On the Anchor rods tab, you can
now use the new Delete top hole
at position setting to define a list
of anchor positions where the top
hole cut is not created.

TSAC-7566

• The cuts created by Concrete
console (110) are now named
according to their position and the
cut part. You can use the names
when creating reports and when
adding dimensions in drawings.

• BEAM_CUT_TOP
• BEAM_CUT_BOTTOM
• BEAM_CUT_FRONT
• COLUMN_CUT_FRONT
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• COLUMN_CUT_FRONT_2

(Second part if the cut has a
complicated shape that cannot
be unioned.)

• BOLT_HOLE_CUT_1
• BOLT_HOLE_CUT_2
• NEOPRENE_HOLE_N (N is an

index of an anchor that creates
the hole.)

• HORIZONTAL_PLATE_HOLE_N
(N is an index of an anchor that
creates the hole.)

TSAC-8642

• There is now a new user-defined
attribute, Load Bearing, for the
created console.

TSAC-7929
Edge and corner reinforcement (62) On the Picture tab, there is a new

setting that you can use to switch
the position of vertical U bars with
horizontal U bars.

TSAC-9190
Floor layout • The default gap is now applied to

all Precast type layers. Previously,
the default gap was only applied
to the first layer with the type
Precast.

TSAC-7700

• You can now define custom
UDAs for cut-outs created
by Floor layout using the
floorlayout.cutouts.inp file.
These UDAs will be shown on the
new Cut-out UDAs tab.

TSAC-9225

• On the General tab, you can use
the new Bind to level setting
to bind the floor layout to the
selected grid level.

TSAC-9651
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Hole reinforcement for slabs and
walls (84)

On the Edge bars tab, you can now
select from all available spacing types
when defining spacing for each edge
bar group.

TSAC-8159
Hollowcore reinforcement strands
(60)

You can now define the strand codes
in a .dat file.

TSAC-8402
Mesh bars / Mesh bars by area When you select Mesh as the bar

creation type on the Picture tab, you
can now use the new Mesh outline
at part edge cuts setting on the
Detailing tab to define how the cuts
at the edges of the parent concrete
object are handled in mesh creation.

Mesh outline at part edge cuts has
the following two options:

• Follow cuts (default value): The
mesh outline polygon follows the
cuts. The mesh is not cut with a
cut part, but instead, there are
more points in the mesh outline
polygon.

With Follow cuts, the mesh
size dimensions and the pull-out
picture take the edge cuts into
account.

• Do not follow cuts: The mesh
outline is created without taking
edge cuts into account, and the
mesh setting Cut by father part
cuts is used to create the cuts to
the mesh.

TSAC-9713
Pad footing reinforcement (77) On the Lacer bar tab, you can

now use the new Local coordinate
system setting to define the creation
plane for the lacer bars, using the
local coordinate system of the pad
footing. Select Yes to ensure that
lacer bars always have the same
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orientation and position on any On
plane rotation as the pad footing.

TSAC-9568
Rectangular column reinforcement
(83)

On the Intermediate links tab, you
can now define the cover thickness
between the intermediate links and
tied side bars.

TSAC-8163
Seating with dowel (75) • On the Picture tab, you can now

extend the column if the beams
are thicker than the column and
do not cover the entire connection
area. You can extend the column
by a specific height relative to
the beam placement level or to
the exact top level position of the
beams.

• On the Parts tab, you can now
define to which cast unit the
bearing pad is attached.

TSAC-7982, TSAC-8476
Seating with dowel to flange (77) On the Parts tab, you can now define

to which cast unit the bearing pad is
attached.

TSAC-8476
Stirrup reinforcement (67) On the Parameters tab, the Rotate

rebar polygon functionality has
been enhanced. There are now two
methods available:

• Predefined: Rotate the rebar
shape polygon from the first
stirrup and the second stirrup. You
can rotate the polygon either at
each even or odd position.
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• Custom: Define a custom

sequence of stirrup rotations for
the first number of stirrups.
This sequence is repeated
automatically for all remaining
stirrups in the beam.

TSAC-7450
Two sided seating with dowel (76) • On the Picture tab, you can now

extend the column if the beams
are thicker than the column and
do not cover the entire connection
area. You can extend the column
by a specific height relative to
the beam placement level or to
the exact top level position of the
beams.

• On the Parts tab, you can now
select between the profile or
polygon type for the nuts on
anchors.

• On the Parts tab, you can now
define to which cast unit the
bearing pad is attached.

TSAC-7982, TSAC-8476
Wall layout • On the Layer tab, there is a

new option, Add to nearest sub-
assembly, in the Layer creation
setting. When you select the new
option, the layer is added as a part
to the nearest, physically closest
sub-cast unit.

If there are two that are equally
close, the first one in creation
order is selected. If there are no
sub-cast units, the part is added
as a sub-assembly and it works
in the same way as Add as sub-
assembly.

TSAC-9207

• On the General tab, you can now
use the new bind to level position
option to bind the wall layout to
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the selected top and bottom grid
levels.

TSAC-9576
Rebar sequence numbering This macro has been removed from

the Applications & components
catalog.

Starting from Tekla Structures 2025,
to assign running numbers to
various reinforcement objects within
each cast unit or pour, define
reinforcement sequence numbering
settings in the Numbering Setup
dialog. Then, use any regular
numbering command, such as
Number modified objects or
Number series of selected objects,
to update the numbering in the
model.

TTSD-72545

6.2 Steel components

Component What's new
Base plate (1004) • On the Anchor rods tab, you

can now select in the Create
assembly from all anchors
setting that shim plates are added
to the anchor rods assembly.

TSAC-9203

• On the Part tab, you can now
define the part and assembly
numbering prefixes and start
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numbers for Fitting plate 2 and
3.

TSAC-9526

• On the Anchor rods tab, you can
now select to create plate washers
as profiles by selecting Yes in
the new Create plate washer as
profile setting. Previously, plate
washers were created only as
contour plates.

TSAC-9660

• On the Anchor rods tab, you can
now select to create washer and
nut profiles as bolt objects by
selecting Yes in the new Create
washer and nut as bolt setting.
You can use this functionality
when plate washers are created.

TSAC-9539
Beam prep (183) You can now select whether a 0.3 mm

tolerance is used in weld access hole
cuts. This tolerance is used to prevent
solid errors when cutting the beam.

TSAC-8981
Bearing plate (7) On the Picture tab, you can now

define the vertical offset of the shim
plate from the secondary part edge.

On the Parts tab, you can now
define the numbering prefix and start
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number, material, and name for the
bottom seat profile.

TSAC-9323, TSAC-9763
Bolted gusset (11) • On the Gusset tab, you can now

define how the cut runs through
the main part, either according
to the gusset plate orientation or
straight.

TSAC-9451

• On the Stiffeners tab, you can
now define the vertical offset of
the stiffeners.

TSAC-9331

• The default bolt edge distances
and spacing for Brace bolts 2 and
Brace bolts 3 are now taken from
Brace bolts 1 when the secondary
parts have the same profile.

TSAC-7426
Bracing wrap around (46) Previously, the component had only

one weld row for all the welds created
by component. This issue has now
been fixed and the different welds
have been separated.

Also, on the Parameters tab, it is
now possible to specify the weld
arrangement for welds between the
clip angles and the input parts or the
gusset. Select whether one weld or
three welds are created.

TSAC-5175
Bracing wrap around 2 (53) Previously, the component had only

one weld row for all the welds created
by component. This issue has now
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been fixed and the different welds
have been separated.

Also, on the Parameters tab, you can
now specify the weld arrangement for
welds between the clip angles and
the input parts or the gusset. Select
whether one weld or three welds are
created.

TSAC-8911
Cast-in plate (1069) On the Studs/Anchors tab, you

can now create studs as custom
components or items.

TSAC-9613
Clip angle (141) On the Bolts tab, there is now a new

option for welds that connect the clip
angle to the main and/or secondary
part.

Use the new option to create one
weld on the vertical part of the clip
angle with a small section on the top
of the clip angle. You can define the
size of this section. The default is 2 x
weld size.

TSAC-9384
Column site weld splice (137) On the Gussets tab, there are

now more chamfer shape options
available for gusset plates. The new
options are:

TSAC-9363
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Column tube seating (100) On the Bolts tab, you can now specify

the bolt offset, and the horizontal and
vertical position of bolts.

Previously, you defined bolt edge
distances, and the number of bolts
and bolt spacing on the Picture tab.

TSAC-9522
Corner tube gusset (56), Corner
bolted gusset (57), Corner wrapped
gusset (63)

On the Gusset tab, it is now possible
to create chamfers on the gusset
plate where the gusset edges connect
to the main part or last secondary
part.

TSAC-9243
Corner bolted gusset (57) On the Stiffeners tab, you can now

define stiffener plates as profiles.

TSAC-8898
Corner wrapped gusset (63) • You can now define the Finish

property for all parts.

TSAC-9259

• On the Picture tab, you can
now define the gusset plate edge
lengths.

TSAC-7580
End plate (101), End plate with
compensating flange plates (111)

On the Bolts tab, you can define the
bolting direction.

TSAC-9600

What's new in components in Tekla Structures
2026

135 Steel components



Component What's new
End plate (101), End plate - Comp
flange (111), Stiffened notch (1006),
Fitting (13), New notch (49), Welded
beam to beam (123)

You can now specify the radius for the
notch cut.

TSAC-9337

End plate detail (1002) On the Parts tab, you can now select
whether to offset the start and end
of welds when the main part is a
rectangular hollow section. When the
welds are offset, the end plate is not
welded to the main part radius.

Also, weld 4 has been added
to control the four sides of
the rectangular hollow sections
separately.

TSAC-9385
Full depth S (185) On the Plates tab, you can now

define the inner bottom edge
chamfer of the shear tab.

TSAC-9066
Haunch (40) On the Parameters tab, you can now

select the chamfer shape for all four
corners of compression stiffeners.
You can now also select to use a
square chamfer.

TSAC-8852
Hollowbrace wraparound gusset
(59)

On the Gusset conn 1 and Gusset
conn 2 tabs, you can now specify the
weld arrangement for welds between
the clip angles and the parts or
gusset. Select whether one weld or
three welds are created.

TSAC-8913
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Joining plates (14) On the Bolts tab, you can now

use the Slots in setting to specify
the parts in which slotted holes are
created.

TSAC-8734
Joining plates (14), Seating (30),
Stub connection (119)

On the Bolts tab, you can now define
the bolting direction.

TSAC-9438
Joist to column, type 1 (161) On the Stb Ang Blts tab, you can now

define the cut length for stabilizer
angle bolts.

TSAC-9305
Multiple stiffeners (1064) You can now create galvanizing holes

in stiffeners on the new Holes tab.

TSAC-9437
New notch (49) It is now possible to create welds 5

and 6 between the main part flanges
and the secondary part.

TSAC-9673
Notched seating (9) On the Parameters tab, you can now

select whether weld 1 is created as a
polygon weld.

TSAC-9260
Railings (S77) • On the Vertical rails tab, you can

now select to cut the horizontal
rail profiles by pickets when
selecting the connection type
between the pickets and the top
and bottom rails.

TSAC-9338

• Bend dimensions cut distances are
now calculated by the component
itself when they are left empty in
the dialog to prevent solid errors
and to correctly create bend.

On the Bends tab, you can
now define the bend dimensions
separately for each of the eight
corners of the stairs.

TSAC-8770
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• On the Middle rails tab, you can

now define closures for middle
rails at the start and at the end of
the railings.

TSAC-7237
Seating (30) On the Bolts tab, you can now define

which bolts are deleted from the bolt
group.

TSAC-9759
Shear plate column with stiffener
special (42)

On the Stiffeners tab, you can now
define the distance between stiffener
plate edges and primary part flanges.

TSAC-7811
Shear plate to tube column (47) Weld 1 has been improved so that it

is now created on both sides of the
main part. Also, on the Parameters
tab, you can now define the Weld
start and end offset.

TSAC-9381
Shear plate tube column (189) On the Plates tab, you can now

define plates washers for bolts and
select the plate washer side.

TSAC-9707
Simple base plate 2 (1031) On the Picture tab, you can now

define different chamfer types at the
corners of the base plate.

TSAC-9389
Simple bolt connection (5) On the Picture tab, you can now

select in the Create fitting setting
whether the secondary part is fitted.

TSAC-9068
Spiral stair (68) On the Stanchions tab, you can now

move the stanchions around the stair
spiral by a given distance.

TSAC-9249
Splice type 1 (56) The component now works with Z

profiles.

TSAC-8246
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Spiral stair (68) On the Stanchions tab, you can now

define to move the stanchion around
the spiral stair by a given distance.

TSAC-9249
Stairs (S71) • On the Stair setup tab, you can

now define the Bolt size and Bolt
standard when the Step type is
Catalog step. This settings will
override the setting read from the
steps.dat file.

TSAC-9002

• On the Bracket tab, you can
now select the main part for the
bracket bolts.

TSAC-9536

• You can now use weld 5 and weld
6 to weld stringer flanges.

TSAC-9578
Stairs (S71), Wooden steps pan
(S72), Polybeam pan (S73)

On the Stair setup tab, you can now
select to create plate stringers as one
continuous plate.

TSAC-9314
Stanchions (S76) On the Parts tab, you can now create

stanchions as twin profiles.

TSAC-7808
Stiffened end plate (27) Horizontal stiffeners have been

improved. On the Parts tab, there
is a new setting Create horizontal
stiffeners where you can select
if only top, only bottom, or both
stiffeners are created. You can
also specify to which part the
stiffeners are welded using the Weld
horizontal stiffeners to setting.
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On the Parameters tab, there are
now separate chamfer settings for
horizontal stiffeners.

TSAC-9310
Stiffened notch (1006) On the Picture tab, you can now

define the stiffener offset from the
end of the beam and the beam cut
tolerance.

TSAC-4981
Stiffeners (1003) On the Parameters tab, you can now

specify whether the left stiffener and
right stiffener are created.

TSAC-9509
Stringer to channel (127) On the Parts tab, you can now define

the width and height of the vertical
plate.

TSAC-8802
Tensioner brace (13), Tensioner
brace and compression bar (13)

You can now also use custom
components for the tensioner
component connections. You can
select the components from the
Applications & components catalog
on the Joints tab.

TSAC-8626
Triangles generation (19) • On the Plate tab, you can now

select in Join plates that plates
are connected by creating an
assembly.

TSAC-9640

• On the Plate tab, you can now
define the numbering prefix and
start number, name, material, and
class separately for the primary
plate and secondary plates.

TSAC-9639
Tube crossing (22) On the Picture tab, you can now

define the brace length on the
connection plate and the end plate
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edge distance from the gusset plate
separately for both secondary parts.

On the Brace conn tab, you can now
define the distance between the cover
plate and the secondary part.

TSAC-7280
Tube gusset (20) • On the Brace conn tab, you can

now define the distance between
the cover plate and the secondary
part.

TSAC-8456

• On the Brace conn tab, you can
now define the length of the cut
in the connection plate when the
plate is cut around the bracing.

TSAC-7540

• On the Gusset tab, you can now
define the height of triangular
gusset plates.

TSAC-6905
Tube rail (113) Bolts are now placed symmetrically

when you have selected to create a
continuous rail on the Parameters
tab.

TSAC-8264
Tube splice (6), Joining plates (14),
Tube gusset (20), Tube crossing (22)

On the Parts, you can now define the
Class property for all parts.

TSAC-9196
Unfold surface (21) On the UDA tab, you can now

define that the component GUID and
unfolded part GUIDs are copied as
UDAs to the original parts.

TSAC-9695
U.S. Base plate (1047) On the Parts tab, you can now define

the Class property of the Key profile.

TSAC-9699
Web stiffened base plate (1016) You can now define the Class

property for all parts.

TSAC-9197
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Welded tee (32) The following improvements have

been made:

• The default number of bolts is
calculated based on the part
height.

• A second weld has been added for
the T profile.

• On the Parameters tab, you can
now use the new Cut extra
material from tee flanges setting
to define that T profile flanges are
cut if they exceed the main part
width.

TSAC-7141
Wraparound gusset (58) • On the Gusset bolts 1 and Gusset

conn 2 tabs, you can now specify
the weld arrangement for welds
between the clip angles and the
parts or gusset. Select whether
one weld or three welds are
created.

TSAC-8912

• On the Brace bolts 1 and Brace
bolts 2 tabs, you can now set
separate bolt spacing for the
gusset side and bracing side.

TSAC-6624
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Wraparound gusset cross (60) On the Brace conn tab, you can now

select whether the brace ends are cut
bevel or square.

TSAC-9253
Z Pan (S74) • On the Stair setup tab, you can

now select whether plate stringers
are created as one continuous
plate.

TSAC-7821

• On the Stair setup tab, you
can now define the Assembly
main part of the stairs assembly:
stringer, bottom landing, or top
landing.

TSAC-7820

6.3 Change in creating components in the Tekla
Structures Graphite configuration
When using the Tekla Structures Graphite configuration, you can now
create detailing components in the same way as when using the Tekla
Structures Diamond configuration. Previously, you could only create
conceptual components in the Tekla Structures Graphite configuration. This
change enables a smooth workflow across the different Tekla Structures
configurations without the risk of breaking the numbering of parts created
by components. Administrators can control this new way of working
(page 165) with the XS_USE_CONCEPTUAL_COMPONENTS_FOR_GRAPHITE
advanced option.

TTSD-73370
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6.4 Improvements in Bridge creator
Reduce processing time in complex bridge modeling with the re-engineered
Bridge creator, now a native Tekla Structures plug-in that stores all
configuration data in component objects instead of external files. The new
centralized station library simplifies station creation and definition processes,
and placement of straight components or beams on curved alignments is
more consistent with chord-based positioning.

Re-engineered Bridge creator
Bridge creator is now a native Tekla Structures plug-in. All configuration data
and geometric parameters are saved directly within the component objects
inside the Tekla Structures model, rather than in external files. This eliminates
the risk of losing design data due to deleted or misplaced external files. To
modify any part of the bridge, double-click the object, and the Bridge creator
plug-in automatically retrieves the specific object properties and logic from
within the model.

Bridge creator now automatically assigns standardized names to geometry
shapes during creation. This means that you do not need to manually name
every shape, and also ensures consistent naming conventions across the
entire project and decreases modeling time.

If Bridge creator is forced to close by an external plug-in or process, a dialog
now appears allowing you to save your changes.

Bridge creator has a new icon on the ribbon and in the Applications &
components catalog:

TSAC-8969, TSAC-9464, TTSD-74917

Work with alignments
In the Bridge creator dialog, click the Read alignment button to open the
Read alignment dialog.

• You can now use an existing reference model inserted in the Tekla
Structures model as an alignment. You can select the reference model,
such as a LandXML file, from the Reference models list. You no longer
need to browse for the file again.

TSAC-9463

In the Bridge creator dialog, click the More button to open the Manage
alignments dialog. The Manage tab contains the following new settings and
features:
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• Next to the Get data from chainage button and the Chainage input box,
there is now the Interval box which you can use for inserting multiple
layout points at a time.

The default value for Interval is zero. If you only enter a value for
Chainage input and keep the interval at zero, only one point is created.
If you keep the chainage input at zero and enter a value for the interval,
layout points are added across the entire alignment. If you enter values
for the Start and End of the area of interest along with an interval value,
points are created at that specified interval throughout the selected area.

The Area of interest boxes have the start and end values of the loaded
main road line.

TSAC-9472

• You can now select any point in the model and automatically retrieve its
reference station from the selected alignment. To do this, use the Project
point on alignment button.

TSAC-9541

• Select the Create construction points checkbox if you want to create
points in the model when displaying chainage along an alignment. When
the checkbox is not selected, physical points are not created, and the
model remains clean and lightweight without redundant overlapping
points.

TSAC-9469

• Select the Create construction line checkbox if you want to create
construction lines perpendicular to the alignment between specific stations
at certain intervals.

TSAC-9480

Manage stations and cross sections
In the Bridge creator dialog, click the Stations button to open the Manage
station library dialog.

• New centralized libraries and rule-based logic handle station creation and
definition with less effort. The new station library allows you to store and
manage predefined key station values. You can manually enter station
values or import them using a .cvs file.

TSAC-9476

• Now you can also define start and end stations using either the Start and
End values or the Start and Length values.

TSAC-9477

In the Bridge creator dialog, click the + button next to the Key sections table
to open the Manage cross section library dialog.
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• Cross section names can now be modified directly in the Section library
list. You no longer need to open the Edit cross section dialog for each
cross section individually.

TSAC-9473

In the Bridge creator or Manage cross section library dialog, select a cross

section and click the  Edit button to open the Edit cross section dialog.

• The point type diagrams that open when you click the Display point
diagram button have been updated to more accurately reflect how
different point types function and interact.

TSAC-9482

• Some texts in the Point type area have been updated to match the texts
shown in the point type diagrams.

TSAC-9861

Define bridge object properties
Tekla Structures 2026 introduces many new settings that are available in the
Bridge creator dialog:

• You can define the cast unit type for extrusions and beams. To do this, go
to the General or Components tab, and in the Cast unit list, select either
Cast in place or Precast.

TSAC-9794

• You can define a class for alignments and cross sections. This can be done
during the creation of extrusions and the conversion of road lines. Class
information can then be used in filtering, for example.

For alignments, click the More button on the General tab, and then go to
the Import tab in the Manage alignments dialog.

For cross sections, go to the Cross section creation area on the General
tab.

TSAC-9793

• When you are placing beams or components, you can specify whether
chainage intervals are measured along the arc or along the chord. Select
an option from the new Interval option list on the Components tab. With
the Along the chord option you can prevent straight components from
clashing with each other when they are placed along a curved alignment
(for example, straight pedestrian parapets placed on a curved bridge).

TSAC-8753

• You can update or swap components in the model without needing to
delete or recreate them. You can change a selected component after

What's new in components in Tekla Structures
2026

146 Improvements in Bridge creator



creation by either reloading a new component or updating the text in the
Name box on the Components tab. All other settings and properties stay
the same.

TSAC-9471

• The default values of the following beam component properties have been
updated on the Components tab: Phase = 1, Class = 1, Part numbering
start number = 1, and Assembly numbering prefix = A.

TSAC-9470

• You can use the new Phase box on the Tension cables tab to define a
phase for tension cables. This ensures that the tension cables are added to
the correct phase immediately upon creation.

TSAC-9479

Fixes
• Previously, when you clicked the Delete button in the Edit cross section

dialog without selecting any points, Bridge creator stopped working. This
issue has now been fixed.

TSAC-9415

• Previously, when you copied a beam component on the Components tab
in the Bridge creator dialog, the phase information was missing from the
copy. This issue has now been fixed.

TSAC-9466
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7 What's new in Template Editor,
templates, and reports in Tekla
Structures 2026

Tekla Structures introduces a new way to produce modern, secure,
and professional-looking Excel reports (.xlsx). Template Editor has several
improvements for managing template layouts and data output.

In Template Editor, you can now align multiline text vertically to the middle,
define custom line spacing, and use UTF8 encoding for textual templates. New
controls also allow you to combine unique text values from sum rows, define
row borders and row background color for Excel reports, and use the new
FindAny() function in formulas. Additionally, the save location for new and
edited graphical and textual templates has changed.

7.1 Create Excel (XLSX) reports
You can now create Excel (.xlsx) reports in Tekla Structures. The content and
formatting of these reports is defined using an .xlsx.rpt template created
with Template Editor, and an .xltx template created with Microsoft Excel.

This new functionality significantly simplifies and modernizes Excel reporting
in Tekla Structures. Earlier, you had to use HTML-based templates or Organizer
to export reports in the .xls format. Compared to these methods, the new
Excel reporting method:

• Eliminates VBA macros: You no longer need to create and maintain
complex, brittle VBA macros, which are difficult to edit and are increasingly
restricted by corporate IT security policies.

• Provides full formatting control: Unlike the limited HTML-based report
(.xls.rpt), this method allows for fully pre-configured Excel templates
(.xltx). You can define company logos, headers/footers, print settings, cell

What's new in Template Editor, templates, and
reports in Tekla Structures 2026

148 Create Excel (XLSX) reports



formats, and advanced table styles. The final report is a native, ready-to-
use Excel file.

• Improves security and compatibility: The resulting modern .xlsx
format is the industry standard and avoids security filters that often block
or quarantine older macro-enabled .xls files.

• Streamlines workflow: The process is more direct and intuitive, reducing
the steps to get a polished, finalized report from Tekla Structures.

How it works

The new Excel export is triggered when you create a report from a template
saved with the .xlsx.rpt file name extension. This method uses two key
components: An Excel template file (.xltx) and a textual Template Editor
template file (.xlsx.rpt).

1. Prepare the Excel template (.xltx).

In Microsoft Excel, design your report layout and save the file as an Excel
template (.xltx) in one of the standard Tekla Structures folders (model,
project, firm, or system).

The Excel template is a standard, pre-formatted Excel template file,
containing the desired final layout (company logos, static text, cell
formatting, formulas, print settings) and special placeholders to tell Tekla
Structures where to insert data.

2. Prepare the Template Editor template (.xlsx.rpt).

In Template Editor, create a new textual template or modify an existing
one and save the template with the .xlsx.rpt file name extension in
your model or company standards folders.

The last line of the header may contain the column headers for the data
rows to be used if column mapping needs to be done. If the columns are
in the same order in both templates, mapping is not necessary. The row
components contain the data to be exported. You can also apply some
formatting properties to the template in Template Editor (background
color, borders, font styles).

3. Export the report.

In the Report dialog in Tekla Structures, select a report template with
the .xlsx file name extension and click Create from all or Create
from selected. In the displayed Export to Excel dialog, select the Excel
template (.xltx) to use, define other export options, and click Export to
generate the .xlsx file.
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The report opens automatically in the associated viewer. For detailed
instructions and option descriptions, see "Prepare and create an Excel (XLSX)
report" in the "Plan and track projects" product guide.
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Notes and limitations

• This new method is an addition, not a replacement. All old methods for
creating Excel reports will continue to work.

• For complex formatting, like using Excel's built-in table styles for alternating
row colors, we highly recommend you to define it within the .xltx Excel
template, rather than relying on the basic formatting options in the .rpt
file.

• Report logic, such as if statements, is still handled within the Template
Editor's value field formulas, not within the export process itself.

• The curly brackets {} are reserved for Tekla Structures attributes, avoid
using them for non-attribute text.

TTSD-72774, TPLED-370

7.2 Template Editor improvements
Align text in value fields

You can now align multiline text vertically to the middle in graphical and
textual templates. Previously, multiline text could only be aligned to the top
or bottom. Also, the Align control has been moved to the Layout area in the
Value Field Properties dialog.
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TPLED-328, TPLED-182, TPLED-343

Define line spacing

In graphical templates, you can now define line spacing for multiline texts
and value fields with the new Line spacing setting. The available options are
Single, 1.15, 1.5, and Double.
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TPLED-151, TPLED-202

UTF8 support in textual templates

Textual templates can now be defined to output text always with UTF8
encoding using the new Output always as UTF8 setting.
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TPLED-373

Combine unique text values from sum rows into single text value

In textual and graphical templates, unique text values in value fields can
now be combined into a single text value when rows are combined. Define
a separator using the new Separator for unique items box in the Value
Field Properties dialog. Use the new Last separator box to define the last
separator individually.

The unique text values in value fields can now be combined and sorted into a
single text value when rows are combined using the new Sort list control.

TPLED-382, TPLED-392
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Define row background color and row borders

• In graphical templates, you can now define an alternate row background
color in the Row Properties dialog using the new Use alternate
background control.

TPLED-197

• In textual templates, in the Row Properties dialog, you can now define the
row background color using the new Background color control, and row
borders for the entire exported row, not just cell-to-cell borders, using the
new Row borders control. The background color and the row borders can
be applied to Excel reports only.

TPLED-286, TPLED-286

Align pictures

In graphical templates, you can now define picture alignment in the Picture
Properties dialog. The Horizontal and Vertical settings are only applied when
the image file is resolved based on a rule and the resulting image is smaller
than the original space reserved for it.

TPLED-324

Support for form feed in output

In textual and graphical templates, a new application type free attribute,
Enable form feed, has been added to the Application tab in Free attributes
in the Template Page Properties dialog. The default value is Yes. Form feed
characters (\f) are enabled by default.
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TTSD-63796

Match graphical template height to drawing height

In graphical templates, you can now set the template height to match the
drawing height using the new Dynamic height checkbox in the Template
Page Properties dialog.

TPLED-198

Percentage available as meaning and as unit

In graphical and textual templates, in the Value Field Properties dialog,
Percentage is now available in the Meaning list, and '%' in the Unit list.
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TPLED-291

New FindAny() function

In graphical and textual templates, the new FindAny() function returns the
offset of a string or character and ends the search when any of the conditions
are met. If the search does not reveal a match, -1 is returned. This works in
both value field formulas and row rules.

Parameters: source string, string (for a character search) OR source string,
substring, substring (for a substring search)

Example of character match
FindAny(GetValaue("DESCRIPTION"), "=; ")
This example searches for the first occurrence of '=', ';' or ' ' in a string and
returns the offset when the first of those is found. The character count for the
string starts at 0.

Example of substring search
FindAny(GetValaue("DESCRIPTION"), "X:", "Y:", "End", "Start")
This example searches for the first occurrence of the strings "X:", "Y:", "End" or
"Start" and returns the offset when the first of those is found. The search for
the strings is case-sensitive, so it will not find instances of "x:", "y:", "end" or
"start".

TPLED-389

Location for graphical (TPL) and textual (RPT) templates

Graphical templates

New and edited graphical template files (.tpl) are now saved in the
\templates folder under the current model folder. By default, Tekla
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Structures searches for the .tpl files from the root of the model folder and
from the \templates folder under the model folder. Previously, graphical
templates were saved in the environment folders.

Textual templates

New and edited textual template files (.rpt) are now saved in the root of
the model folder and searched from there. Previously, textual templates were
saved in the environment folders.

TTSD-73091
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8 What's new in template
attributes in Tekla Structures
2026

Tekla Structures 2026 introduces some new template attributes and changes
in existing templates.

You can use template attributes in filtering and in drawing and report
templates. When you open a drawing or create a report, Tekla Structures
uses the attributes and formulas to calculate and display information from the
model database. The template attributes that are available in a template row
definition depend on the content type of the row.

8.1 New template attributes
• Use the BIND_TO_LEVELS template attribute to report all parts that have

been bound to grid levels. The attribute returns 1 if the part is bound to a
grid level, and 0 if the part is not bound to any grid level.

TTSD-70773

• The new IMAGE_ID template attribute shows the image ID in the format
<Id>-<SubId>. This attribute is used in reports and in some exports when
exporting image ID information, for example, in the BVBS export.

TTSD-71601

• Now you can get the full file name including the file name extension and
the full file path including the full file name of the current report using the
new template attributes OUTPUT_FILENAME and OUTPUT_FILEPATH. You
can use these attributes in the report template footer, for example.

TPLED-318
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8.2 Changed template attributes
REBAR and SINGLE_REBAR content types to support level attributes

The content types REBAR and SINGLE_REBAR now support the following level-
related template attributes:

TOP_LEVEL

TOP_LEVEL_GLOBAL

TOP_LEVEL_BASEPOINT

TOP_LEVEL_PROJECT

BOTTOM_LEVEL

BOTTOM_LEVEL_GLOBAL

BOTTOM_LEVEL_BASEPOINT

BOTTOM_LEVEL_PROJECT

These template attributes can be used to get the top level and bottom level
values in reports and in rebar marks for rebar objects, such as single bars, bar
groups, and rebar set bar groups.

Limitation: A rebar group in SINGLE_REBAR content type can only get a value
for the whole rebar group instead of values for individual bars in the rebar
group.

TTSD-69106

New content types for building hierarchy elements

The content types BUILDING, BUILDING_SECTION, and BUILDING_STOREY
are now available along with their user-defined attributes.

TTSD-69723

Assembly bounding box attributes to use unrestricted extrema

The bounding box template attributes for assemblies
(ASSEMBLY.BOUNDING_BOX_MIN/MAX_X/Y/Z ), such as
ASSEMBLY.BOUNDING_BOX_MIN_X, now use unrestricted extrema, which
means that the drawing view restriction box does not affect the value.

TTSD-66559
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9 What's new in advanced
options in Tekla Structures
2026

In Tekla Structures 2026, there are some new advanced options, and some of
the advanced options have become obsolete.

You can use advanced options for configuring Tekla Structures to suit the
way you work, or to comply with specific project requirements or industry
standards. You can change advanced options values in the Advanced options
dialog, or in the initialization files.

9.1 New advanced options
XS_DRAWING_TEXT_FILE_OBJECT_USE_EXTERNAL_EDITOR

The new XS_DRAWING_TEXT_FILE_OBJECT_USE_EXTERNAL_EDITOR advanced
option controls which editor opens when you select to edit a linked .txt
or .rtf file in a text editor. Set this advanced option to TRUE to always use
the associated external application for viewing and editing the .txt and .rtf
files. Set it to FALSE to use the new Tekla Structures built-in text editor. FALSE
is the default value.

This advanced option is located in the Drawing properties category of the
Advanced options dialog.

TTSD-73127

XS_DSTV_LIST_WEIGHT

NET weight is primarily required for plates and GROSS weight for profiles. A
new advanced option, XS_DSTV_LIST_WEIGHT, has been added for specifying
whether gross or net weight is used in the part lists in the NC export. There are
three options available:
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WEIGHT - Checks if the part is a plate, and uses net weight for plates and gross
weight for profiles in part list export.

WEIGHT_NET - Uses net weight in part list export.

WEIGHT_GROSS - Uses gross weight in part list export.

This new advanced option is located in the CNC category of the Advanced
options dialog.

XS_DSTV_LIST_WEIGHT replaces the old advanced option
XS_DSTV_LIST_NET_WEIGHT.

This new advanced option was already introduced in Tekla Structures 2025
SP1.

TTSD-67596

New advanced option for controlling drawing view placing and scaling in
cloning

A new advanced option, XS_DRAWING_CLONING_VIEW_PLACING, has been
added to control drawing view placing and view and sheet size scaling when a
drawing is cloned. TRUE, SCALE, SHEET is the default value allowing views to
be replaced and resized during cloning.

We recommend that you use the default value with this advanced option.
If automatic scaling of drawing views (Layout --> Scale --> Autoscale) or
automatic size of drawing sheets (Layout --> Drawing size --> Size definition
mode --> Autosize) are not used in your projects, you can change default
value to TRUE.

Previously, view placing and view and sheet size scaling were controlled
for both drawing cloning and update by the advanced option
XS_DRAWING_UPDATE_VIEW_PLACING. However, you often need different
behavior when you are either cloning or updating a drawing, and now this
behavior can be controlled separately.

XS_DRAWING_UPDATE_VIEW_PLACING now only affects view placing and view
and sheet size scaling during drawing updates. You can use the same values
for both advanced options: TRUE (default), FALSE, SCALE, SHEET, and GA. The
value CLONING_ONLY has been removed.

This new advanced option was already introduced in Tekla Structures 2025
SP1.

TTSD-68946

XS_REBAR_BENT_MESH_PULLOUT_DIMENSIONS_INCLUDE_LONGITUDINAL_
BARS

An advanced option, XS_REBAR_BENT_MESH_PULLOUT_DIMENSIONS_
INCLUDE_LONGITUDINAL_BARS, has been added to control whether
longitudinal bars are taken into account in the dimensions shown in a rebar
pull-out picture for a bent mesh. Set this advanced option to TRUE to take into
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account the longitudinal bars, and FALSE to ignore them. TRUE is the default
value. This advanced option affects pull-out pictures in marks and templates.

This advanced option is located in the Drawing properties category of the
Advanced options dialog.

TTSD-74429

XS_ENABLE_MODEL_EDITING_IN_GA

The new XS_ENABLE_MODEL_EDITING_IN_GA advanced option controls
whether you can edit a model while having a general arrangement drawing
open. The default value of the advanced option is TRUE, which means that
editing the model is possible.

This advanced option is located in the Modeling properties category of the
Advanced options dialog.

TTSD-69686

XS_USE_CONCEPTUAL_COMPONENTS_FOR_GRAPHITE

In the Tekla Structures Graphite configuration, detailing components
can now be created in the same way as in the Tekla Structures
Diamond configuration. This change is enabled with the new
XS_USE_CONCEPTUAL_COMPONENTS_FOR_GRAPHITE advanced option that
is by default set to FALSE. If the advanced option is set to TRUE, only
conceptual components can be created in the Tekla Structures Graphite
configuration. We recommend that this system-specific advanced option is
used by administrators only.

Previously, only conceptual components could be created in the Tekla
Structures Graphite configuration.

TTSD-73370

9.2 Obsolete advanced options
APPL_ERROR_LOG

This advanced option is no longer supported. Instead, use the XS_LOGPATH
advanced option.

TTSD-69882

XS_ADAPTIVE_OBJECTS

This advanced option has been hidden from the Tekla Structures user
interface. Instead of this advanced option, you can use the Default adaptivity
setting in File --> Settings --> Options --> General.

TTSD-70206
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XS_DSTV_LIST_NET_WEIGHT

This advanced option has been replaced with the advanced option
XS_DSTV_LIST_WEIGHT. XS_DSTV_LIST_NET_WEIGHT was used for setting
either net weight (TRUE) or gross weight (FALSE) for part lists in the NC export.

TTSD-67596

XS_ARC_WIDTH_OF_CLOUD

This advanced option has been hidden from the Tekla Structures user
interface. It was used to control the width of cloud arcs for the entire model.
Now you can define the cloud arc width for each cloud instance separately in
the Cloud property pane using the Width property.

TTSD-72994

Advanced options for rebar visibility

The following advanced options have been hidden from the Tekla Structures
user interface:

• XS_REBARSET_SHOW_LEGFACES
• XS_REBARSET_SHOW_GUIDELINES
• XS_REBARSET_SHOW_PROPERTY_MODIFIERS
• XS_REBARSET_SHOW_SPLITTERS
• XS_REBARSET_SHOW_END_DETAIL_MODIFIERS
• XS_DISPLAY_DIMENSIONS_WHEN_SELECTING_REBARS
• XS_REBARSET_COLOR_BARGROUPS
Instead of these advanced options, you can use the Rebar --> Visibility
commands on the ribbon, or the keyboard shortcuts Alt+1...7.

TTSD-74620

9.3 List of obsolete advanced options across Tekla
Structures versions
The Obsolete advanced options page provides information about the
advanced options that have become obsolete in Tekla Structures in version
2018 and newer.
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10 Tekla Structures 2026
administrator's release notes

Administrator's release notes provide information about new features and
enhancements for advanced users that are available in a new Tekla Structures
version.

For general upgrade instructions for administrators, see .

For feature-specific instructions for how to apply additional customizations
related to new features, see these feature pages in the Tekla Structures 2026
release notes (page 7).

• New clipboard for copying and pasting model and drawing objects
(page 13)

• New way to manage model views: Model views side pane (page 19)

• Easy way to set the model background color (page 27)

• Bind parts to grid levels (page 33)

• New Freeze rebar sets command and other updates in reinforcement
features (page 39)

• Intuitive 2D sketching, editing, and annotations in drawings (page 65)

• Integrated Trimble Connect property sets (page 97)

Administrator's release notes contents:

10.1 Administrator's release notes: Licensing changes in
Tekla Structures 2026
Tekla Structures 2026 includes these changes related to licensing.
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Changes to user management and terminology related to
licensing
To prepare for unifying user and license management systems across different
Trimble products, there are changes to terminology, and to how users belong
to company accounts (previously called organizations) in Tekla Structures
2026.

Changes to terminology

For consistency between different systems, terminology related to users and
licensing has been updated in Trimble User Assistance and in the user
interfaces of these Tekla online services:

• Tekla Online Admin Tool

• Tekla Warehouse

• Online Profile for Tekla products and services

Previous term New term
Organization Account
External license user Member

The term employee has not changed, but now refers to a role that is assigned
to users rather than membership in an account. The account where a user has
the employee role is the user’s home account.

Changes to user management

Previously, users were automatically invited as employees unless you invited
them as external license users in the Tekla Online Admin Tool. Now, you
must select the employee role to invite new users as employees. Users must
have the employee role to be able to access the company's content in Tekla
Warehouse and to share the models that belong to the company's account in
Tekla Model Sharing.

Compatibility with legacy on-premises licensing tools
To use Tekla Structures 2026 with legacy on-premises licensing tools, you must
upgrade to the 2025 version of the licensing tools.

Tekla Structures 2026 is not compatible with earlier versions of these legacy
on-premises licensing tools:

• Tekla License Server (Tekla License Administration Tool)

• Tekla License Borrow Tool

• Tekla On-Demand License Administration Tool
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Change in Tekla Structures Graphite configuration - now
creating detailing components
The Tekla Structures Graphite configuration has been changed so that
detailing components can now be created in the same way as in the Tekla
Structures Diamond configuration. Users in both configurations can now
work with components confidently, without the risk of breaking the numbering
of parts created by components. Previously, only conceptual components
could be created in the Tekla Structures Graphite configuration.

Administrators can control the creation of components in the Tekla
Structures Graphite configuration with the new advanced option. We
recommend that this advanced option is used by administrators only. The
advanced option is system specific and is read from teklastructures.ini.
Administrators are recommended to specify the option in the options.ini
file in XS_FIRM for all users.

The default value of the advanced option is FALSE, which means that
components are created in the same way as in the Tekla Structures Diamond
configuration. If set to TRUE, only conceptual components can be created in
the Tekla Structures Graphite configuration.

TTSD-73370

10.2 Administrator's release notes: New in Tekla Model
Sharing
In Tekla Structures 2026, the new On-premises Management Console for
Tekla Model Sharing is now available. There are also changes to compatibility
between different versions of Tekla Structures and on-premises tools for Tekla
Model Sharing.

On-premises Management Console for Tekla Model Sharing
The new On-premises Management Console for Tekla Model Sharing provides
browser-based access for administrators to manage models that are shared
using an on-premises sharing service for Tekla Model Sharing.

The On-premises Management Console for Tekla Model Sharing runs on the
same server as the on-premises sharing service for Tekla Model Sharing. The
On-premises Management Console works in the same way as the cloud-based
Management Console, with these exceptions:

• Malware scanning is not available in the On-premises Management
Console for Tekla Model Sharing.

• Settings related to the model data storage location are not available
in the On-premises Management Console for Tekla Model Sharing. The
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geographical location of your private on-premises sharing service for Tekla
Model Sharing is the model data storage location.

• The Notifications page is not available in the On-premises Management
Console for Tekla Model Sharing.

• The On-premises Management Console for Tekla Model Sharing uses
Windows Active Directory to authenticate administrators. The user profile
shows the Windows user information of the current user.

Compatibility with on-premises tools for Tekla Model
Sharing
Due to changes in the on-premises tools for Tekla Model Sharing that are not
backward compatible, there are now parallel versions of the tools that are
compatible with different versions of Tekla Structures.

Tekla Structures 2026 requires version 4 of these on-premises tools for Tekla
Model Sharing:

• On-premises sharing service for Tekla Model Sharing

• On-premises Management Console for Tekla Model Sharing

• Cache service for Tekla Model Sharing

Version 3 of these tools is compatible with Tekla Structures 2020 to 2025.

If you use both Tekla Structures 2026 and an earlier version of Tekla
Structures, you can install both versions of the on-premises tools for Tekla
Model Sharing.

10.3 Administrator's release notes: Improvements in the
new profile catalog
These improvements have been made in the new profile catalog in Tekla
Structures 2026.

The new profile catalog is now enabled by default in the default environment.
If you use a custom environment where the new profile catalog is not enabled,
add set XS_USE_OLD_PROFILE_CATALOG=false to one of these files:

• The env_global_default.ini file in the Environments\common folder

• The env_<EnvironmentName>_environment.ini file in a specific
environment folder.

You can now do these tasks in the new profile catalog:

• Manage user-defined attributes (UDAs) in profiles

• Upload profiles and groups from a model to Tekla Warehouse
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• Insert profiles and groups from Tekla Warehouse into a model

• Modify sketched parametric profiles

• Modify parametric profiles with variable cross sections.

We recommend that all users use the new profile catalog, but if you want to
continue using the original profile catalog, you can re-enable it.

10.4 Administrator's release notes: Miscellaneous general
improvements
This version of Tekla Structures includes these general improvements.

New advanced option: XS_DSTV_LIST_WEIGHT
The new XS_DSTV_LIST_WEIGHT advanced option replaces the old
XS_DSTV_LIST_NET_WEIGHT advanced option.

For more information, see What's new in advanced options in Tekla Structures
2026 (page 161).

Change the value of the advanced option in your .ini file if needed.

TTSD-67596

End Condition UDAs for bent plates and lofted plates
End Condition UDAs are now also available for bent plates and lofted plates.

If you use a custom objects_EndConditions.inp file, add these attributes
to your objects_EndConditions.inp file:

/
**************************************************************************
*/
/* Bent plate attributes */
/
**************************************************************************
*/
bentplate(0,"j_bent_plate")
{
 tab_page("EndConditions","jd_EndConditions",6) 
 modify(1)
}

/
**************************************************************************
*/
/* Lofted plate attributes */
/
**************************************************************************
*/
loftedplate(0,"j_lofted_plate")
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{
 tab_page("EndConditions","jd_EndConditions",6) 
 modify(1)
}

TTSD-68165

10.5 Administrator's release notes: Project Settings
Management Console (Preview)
The Project Settings Management Console is a web-based tool that lets
you manage your project settings, environments, and other project files in
the cloud. You can create custom cloud-based environments to enhance
collaboration and ensure consistent settings for users who open models using
Tekla Launcher.

Creating and sharing project settings in the Project Settings Management
Console is an alternative to distributing customized settings using files in the
project or firm folders.

With the Project Settings Management Console, you can:

• Gather your collections, dependencies, and organization standards in the
Project Settings Management Console.

• Test your settings in the cloud-based sandbox without affecting projects in
production use.

• Publish the finalized settings to the cloud to make them available for all
users who work on the project.

After you publish the settings, Tekla Launcher automatically gets the latest
published settings from the cloud. Users can create new models where all
users have consistent settings.

For more information, see .

10.6 Administrator's release notes: Steel settings
The following customization settings only apply to the steel user group.

Administrator's release notes: Steel components
There are several improvements in steel components in Tekla Structures 2026.
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Update your standard files if you want to use your own default values for the
new options and features.

For more information about these improvements, see What's new in
components in Tekla Structures 2026 (page 125) in the Tekla Structures 2026
release notes.

10.7 Administrator's release notes: Concrete settings
The following customization settings only apply to the concrete user group.

Administrator's release notes: Concrete components
There are several improvements in concrete components in Tekla Structures
2026.

Update your standard files if you want to use your own default values for the
new options and features.

For more information about these improvements, see What's new in
components in Tekla Structures 2026 (page 125) in the Tekla Structures 2026
release notes.
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notes
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11 Tekla Structures Localization
release notes

Localization release notes for Tekla Structures introduce new and changed
features specific to different environments in the new Tekla Structures version.

Localization release notes list the features that have been localized in your
environment and provide guidance in customization tasks. These release
notes are provided by the localization teams at local areas and reseller offices.
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12Disclaimer

© 2026 Trimble Inc. and affiliates. All rights reserved.

Use of the Software and of this Software Manual are governed by a License
Agreement which determines whether you are an authorized user of the
Software and the Software Manual. The warranties and disclaimers set forth
in the License Agreement apply to the Software and the Software Manual.
Neither the Trimble entity granting the license nor any of its affiliates assume
responsibility that the text is free of technical inaccuracies or typographical
errors. The right to make changes and additions to this manual is reserved.

Trimble and certain product names are registered trademarks of Trimble Inc.
in the United States, the European Union and other countries and may have
similar statutory protections. Trademarks of third parties are not mentioned in
this Manual to suggest an affiliation with or endorsement by their owners.

Elements of the software described in this Manual may be the subject of
pending patent applications in the European Union and/or other countries.

Portions of this software:

Portions of this software make use of Open CASCADE Technology software.
Open Cascade Express Mesh Copyright © 2019 OPEN CASCADE S.A.S. All rights
reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

This application incorporates Open Design Alliance software pursuant to a
license agreement with Open Design Alliance. Open Design Alliance Copyright
© 2002–2020 by Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

RapidXml C++ library © All rights reserved.

FlexNet Publisher © 2016 Flexera Software LLC. All rights reserved. This
product contains proprietary and confidential technology, information and
creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission
of such technology in whole or in part in any form or by any means
without the prior express written permission of Flexera Software LLC is
strictly prohibited. Except where expressly provided by Flexera Software LLC
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in writing, possession of this technology shall not be construed to confer any
license or rights under any Flexera Software LLC intellectual property rights,
whether by estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures --> 3rd party licenses
and then click the option.
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